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Safety Information

The products described in this manual can fail in a variety of modes due to misuse, age, or malfunction and is not
designed or intended for used in systems requiring fail-safe performance, including life safety systems. Systems
with the products must be designed to prevent personal injury and property damage during product operation
and in the event of product failure.

FreeWave Technologies, Inc. warrants the FreeWave® FreeWave Tool Suite (Product) that you have purchased
against defects in materials and manufacturing for a period of one year from the date of shipment, depending on
model number. In the event of a Product failure due to materials or workmanship, FreeWave will, atits discretion,
repair or replace the Product. For evaluation of Warranty coverage, return the Product to FreeWave upon
receiving a Return Material Authorization (RMA). The replacement product will remain under warranty for 90
days or the remainder of the original product warranty period, whichever is longer.

IN NO EVENT WILL FREEWAVE TECHNOLOGIES, INC., ITS SUPPLIERS, OR ITS LICENSORS BE LIABLE FOR ANY DAMAGES ARISING
FROM THE USE OF OR INABILITY TO USE THIS PRODUCT. THIS INCLUDES BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, INABILITY TO ACCESS OR SEND COMMUNICATION OR DATA, PERSONAL INJURY OR DAMAGE, OR OTHER LOSS
WHICH MAY ARISE FROM THE USE OF THIS PRODUCT. THE WARRANTY IS EXCLUSIVE AND ALL OTHER WARRANTIES EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE
ARE EXPRESSLY DISCLAIMED.

FreeWave’s Warranty does not apply in the following circumstances:

1. If Product repair, adjustments, or parts replacements are required due to accident, neglect, or undue
physical, electrical, or electromagnetic stress.

2. IfProductis used outside of FreeWave specifications as stated in the Product's data sheet.

If Product has been modified, repaired, or altered by Customer unless FreeWave specifically authorized
such alterations in each instance in writing. Where applicable, this includes the addition of conformal
coating.

FreeWave Technologies, Inc.
5395 Pearl Parkway, Boulder, CO 80301
303.381.9200
Toll Free: 1.866.923.6168
Fax: 303.786.9948
Copyright © 2019 by FreeWave Technologies, Inc.

) www.freewave.com
All rights reserved.
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Preface

Contact FreeWave Technical Support

For up-to-date troubleshooting information, check the Support page at www.freewave.com.
FreeWave provides technical support Monday through Friday, 8:00 AM to 5:00 PM Mountain
Time (GMT -7).

«» Calltoll-free at 1.866.923.6168.

o In Colorado, call 303.381.9200.

« Contact us through e-mail at support@freewave.com.

Additional Information

Note: Use the support.freewave.com website to download the latest documentation for the Tool
Suite.
Registration is required to use this website.

Document Styles
This document uses these styles:
« Products and applications appear as: FreeWave.
« Parameter setting text appears as: [Page=radioSettings]
« File names appear as: .
« File paths appear as: C:\Program Files (x86)\FreeWave Technologies.
o User-entered text appears as: XXXXXXXXX.
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! Caution: Indicates a situation that MAY cause damage to personnel, the radio, data, or
network.

Example: Provides example information of the related text.

FREEWAVE Recommends: Identifies FreeWave recommendation information.

[ Important!: Provides crucial information relevant to the text or procedure. ]
[ Note: Emphasis of specific information relevant to the text or procedure. ]
sV,

Provides time saving or informative suggestions about using the product.

Warning! Indicates a situation that WILL cause damage to personnel, the radio, data, or
network.
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1. Tool Suite Overview

FreeWave Tool Suite provides easy, reliable, and repeatable programming and monitoring tools
for FreeWave serial and Ethernet wireless data radios, I/O Serial Base devices, and Expansion
Modules.

These are the applications available in Tool Suite:

Tool Suite consists of applications used to configure devices and run diagnostics to determine
how well the devices in the network are performing.

« Configuration Application (on page 38)

« Use to program devices according to specific network requirements.
« Network Diagnostics Application (on page 68)

« Use to view performance data in real-time from the network.
« Local Diagnostics Application (on page 65)

« Use toview a real-time snapshot of MultiPoint setups that measure the signal-to-noise
level of a device .

« Spectrum Tool Application (on page 96)

« Use to monitor the ambient noise at various points in the spectrum as a serial device hops
through them. The Spectrum Tool is available for 900 MHz, 2.4 GHz, and 1.3 GHz serial
devices only.

« Setup Terminal Application (on page 93)
« Use to configure device using a terminal window.

« The Setup Terminal application mirrors the menu structure seen using
HyperTerminal.

« Updates Application (on page 99)

« Use toreview the changes in the latest version of Tool Suite and to verify the latest Tool
Suite version is installed.
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Important!: If changes are made to radio settings, the changes are NOT made on the device until
they are sent to the device.
For more information, see Program Devices from the Device Tree (on page 43).

Notes

« Changes made in Tool Suite are saved automatically.

« Forinformation about configuration settings for each FreeWave device, see that device's
user manual or addendum.
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2. Installing and Upgrading Tool Suite

Tool Suite is compatible with these operating systems:
« Windows 2003 Service Pack 1
o Windows XP Service Pack 2
« Windows Vista
« Windows 7 or higher
Continue with:
« Install Tool Suite (on page 12)
« Updates Application (on page 99)

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

Use the support.freewave.com website to download the latest documentation for the Tool Suite.
Registration is required to use this website.
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2.1. Install Tool Suite

[ Note: The images in this document and/or procedure are for Windows® 10 and/or Firefox®. ]

1. Login to the support.freewave.com site.

[ Note: Registration is required to use this website. ]

2. Click Software > Tool Suite.

3. Click the Tool Suite v2.11.2 - Web Based link to download the Tool Suite install file
to the computer.

4. Locate the downloaded software and double-click the . file to extract the installation
file.

Important!: If this is the first time Tool Suite is installed on the computer, the installer
verifies the Microsoft .NET Framework 3.5 and Microsoft SQL Server Compact 3.5
required files are installed.

If they are not on the computer, Tool Suite installer installs them.

See Installing the Microsoft .NET Framework and Installing Microsoft SQL Server Compact
(on page 17) for information.

. J

The installation wizard starts. Figure 1

]*5' Freewave Tool Suite Setup

Welcome to the Freewave
Tool Suite Setup Wizard

The Setup Wizard will install Freewave Tool Suite on your
computer. Click "™Mext” to continue or "Cancel” to exit the
Setup Wizard.

< Back Cancel

Figure 1: Tool Suite Install Wizard - Welcome

5. Click Next to continue.
The Tool Suite Install Wizard - Choose Setup Type dialog box appears. Figure 2
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15 Freewave Tool Suite Setup X

Choose Setup Type
Choose the setup type that best suits your needs

Typical

Installs the most common program features. Recommended for
most users.

Custom

Allows users to choose which program features will be installed
and where they will be installed. Recommended for advanced
users,

Complete

All program features will be installed. {Requires most disk
space)

Advanced Installer

Figure 2: Tool Suite Install Wizard - Choose Setup Type

6. Clickthe Complete setup button to run and click Next.
The Tool Suite Install Wizard - Ready to Install dialog box appears. Figure 3

[ Note: If this is the first time Tool Suite is installed, select Complete and click Next. ]
15 Freewave Tool Suite Setup X
Ready to Install

The Setup Wizard is ready to begin the Freewave Tool Suite installation

Click "Install” to begin the installation. If you want to review or change any of your
installation settings, dick "Back”. Click "Cancel” to exit the wizard.

Advanced Installer

< Back Instal Cancel

Figure 3: Tool Suite Install Wizard - Ready to Install

7. Click Install to continue.
Tool Suite is installed.
The Tool Suite Install Wizard - Finish dialog box appears when the installation is
completed. Figure 4
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Note: Microsoft Report Viewer Redistribution 2008 SP1 is automatically installed with
Tool Suite.

15 Freewave Tool Suite Setup X

Completing the Freewave Tool
Suite Setup Wizard

Click the "Finish™ button to exit the Setup Wizard.

Launch Freewave Tool Suite

Figure 4: Tool Suite Install Wizard - Finish

8. Click Finish to exit and launch Tool Suite.
9. Optional: Continue with Connecting Radios to a Computer (on page 20).

2.1.1. Recommended Computer Display Settings

When running Tool Suite, use a minimum resolution of 1024 x 768 to achieve optimal visual
performance on the computer.

Note: Depending on the system setup, Administrative rights to the computer may be required to
make these changes.

Important!: A 120 DPI setting is not supported (graphics may not align and some text may be
partially hidden).
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2.2. Installing the Microsoft .NET Framework

This procedure assumes Microsoft .NET Framework is being installed from the Tool Suite
installer.

See Install Tool Suite (on page 12).

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

Procedure
The Microsoft .NET Framework is missing message appears. Figure 5

|5 Windows Features

An app on your PC needs the following Windows feature:

NET Framework 3.5 (includes MET 2.0 and 3.0}

!; Download and install this feature

Windows will get the files that it needs from Windows Update and complete the installation.

—> Skip this installation

Your apps might not work correctly without this feature.

Tell me more about this feature

Cancel

Figure 5: Microsoft NET Framework 3.5 Missing Message

3. Click the Download and install this feature link.
The software is downloaded and installed. Figure 6
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[ Windows Features

Downloading required files

Cancel

Figure 6: Microsoft .NET Framework 3.5 Downloaded and Installed

The Installation Complete message appears. Figure 7

[ Windows Features

The following feature was successfully installed:

NET Framework 3.5 (includes NET 2.0 and 3.0}

You might need to restart apps that require this feature.

Close

Figure 7: Microsoft .NET Framework 3.5 Installation Complete message

4. Click Close to exit.
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2.3. Installing Microsoft SQL Server Compact

This procedure assumes Microsoft SQL Server Compact is being installed from the Tool
Suite installer.

See Install Tool Suite (on page 12).

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

Procedure
The installation wizard starts. Figure 8
13 Microsoft SQL Server Compact 3.5 SP2 ENU X
" Welcome to the Microsoft SQL Server
Compact Setup

Setup helps you install, repair or remove Microsoft SQL Server
Compact. To continue, dick Next.

» WARMING: This program is protected by copyright law and
international treaties.

Figure 8: Microsoft SQL Server Compact 3.5 SP2 ENU Wizard -
Welcome

1. Click Next to continue.
The License Agreement dialog box opens. Figure 9
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]ﬁ Microsoft SOL Server Compact 3.5 5P2 ENU x

License Agreement

Please read the following license agreement carefully. You must accept the license
agreement before continuing forward.

MICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT SQL SERVER COMPACT 3.5 WITH
SERVICE PACK 2

These license terms are an agreement between Microsoft Corporation (or
based on where you live, one of its affiliates) and you. Please read them.
They apply to the software named above, which includes the media on which
v rersived it if any The tarme alen annlv tn anv Mirrnenft

(®) 1 accept the terms in the license agreement

()1 do not accept the terms in the license agreement

Figure 9: Microsoft SQL Server Compact 3.5 SP2 ENU Wizard -
License Agreement

2. Read the license agreement, select the | accept the terms of the license agreement

option button and click Next.
The Ready to Install dialog box opens. Figure 10

jﬁl Microsoft SOL Server Compact 3.5 5P2 ENU x

Ready to Install the Program
Setup is ready to beqin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, didk Back. Click Cancel to
exit Setup,

Installation Path

C:\Program Files (x86)\Microsoft SQL Server Compact Editiony

< Back Instsll Cancel

Figure 10: Microsoft SQL Server Compact 3.5 SP2 ENU Wizard -
Ready to Install
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3. Click Install to continue.
The Microsoft SQL Server Compact is installed.
The Finish dialog box appears when the installation is completed. Figure 11

jﬁl Microsoft SOL Server Compact 3.5 5P2 ENU ht
. Completing the Microsoft SQL Server Compact
Setup

Setup has installed Micrasoft SQL Server Compact successfully.
Click Finish to exit.

Figure 11: Microsoft SQL Server Compact 3.5 SP2 ENU Wizard -
Finish

4. Click Finish to exit.
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2.4. Connecting Radios to a Computer

To read and program a radio using Tool Suite, connect the radio to a computer that runs Tool
Suite software.

1. Connect a serial or diagnostic cable between the computer's COM port and the radio.
Using a diagnostic cable is recommended.

2. Connectthe power supply to the radio and place the radio into Setup mode.

Use a serial cable for both Configuration and Setup Terminal applications.
\\17, However, a Diagnostics cable is required to run diagnostics using the Network or Local
Diagnostics applications.
= For Diagnostics only, functionality is available via TCP/IP if routing through a Terminal server
to reach the serial Master radio.
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3. Tool Suite Navigation

The buttons, ribbons, and toolbars in Tool Suite are used to navigate to different areas of Tool
Suite. Options are also available using the right-click and left-click buttons on the mouse.

These sections describe the navigation tools available and when to use them.
« Recommended Computer Display Settings (on page 14)
« Ribbons and Toolbars (on page 22)
« File Drop-down Menu (on page 23)
« Field Tool Tips (on page 24)
» Access Individual Device Options (on page 24)
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3.1. Ribbons and Toolbars

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

« Ribbons refer to the toolbars that have either the FreeWave logo on them or the title bars
underneath that show the network name.

« The sections are used to group buttons with like functionality together on these ribbons and
are specific to the application open in Tool Suite.

[ Note: The terms “ribbon” and “toolbar” are used interchangeably throughout this documentation. J
Serial Configuration a_
e A‘ & %} %} w Y € ﬁ Default Network e
N/A - Read Read Upgrade Upgrade View Add Import  Verify F R E EWAVE
- Radio Serial Base | Radio Module ~ Available | Metwork Metwork Database -
Communication Firmware Datastore Networks

Figure 12: Configuration Application Ribbon

Below the main ribbon is a smaller Network Title ribbon that shows the name of the network that
is currently selected. Figure 13 and Figure 14

Important!: This smaller ribbon only appears in the Configuration Application (on page 38) and
Network Diagnostics Application (on page 68).
It includes additional options that apply to those applications.

é‘i' FreeWave FGRs (FreeWave Technologies, Inc) - Configuration 7 Filler & Options

Figure 13: Configuration Application with Network Title Ribbon

f:_’? FreeWave FGRs (FreeWave Technologies, Inc) - COM1 “ ¥ Polling 7 Filter Tl Search ¥ Optisrs

Figure 14: Network Diagnostics Application with Network Title Ribbon
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3.2. File Drop-down Menu

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

The File drop-down menu in the main ribbon functions similar to a File menu in most Windows®

software programs.
“ Serial Configuri

Hide Applications

Back Up Data
Help F

Exit

Figure 15: File Drop-down Menu

Use the File menu to access this functionality:

« Hide Applications - Shows or hides the Application pane that displays on the left side of
Tool Suite.

« Back Up Data - Use to save a backup copy of the file, which contains all
Tool Suite data.

Note: For more information, see Back Up Tool Suite Data (on page 100).

« Help > About - Shows the Tool Suite software version information.
« Exit - Closes Tool Suite.
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3.3. Field Tool Tips
Use the mouse to hold the cursor over a parameter setting to view a brief description about that
parameter's function. Figure 16

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

o - Mone - 1 hd
Serial Interface R5232 .
Turn On Delay 1]
Flow Contral Mone -

|Determines the Hardware Flowe conkral For the Data Port, L

Figure 16: Example: Field Tool Tip

[ Note: This feature does not apply to I/O Expansion menus. ]

3.4. Access Individual Device Options

A device's options depends on its operation mode (e.g., Master or Slave).
Right-click the device to access specific options for that device. Figure 17

Master - [926-1604)
N FGR 90 N

= View Report.
Repeat —
B FGR 90 (_; Build Metwork Design..

_9 Slave 3 H, Expart..

FGR 90
Repeat| J§ Delete
[ dik PR GnTTET SETTET

Figure 17: Example: Device Tree in the Configuration Application
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4. Network Files and Settings

In Tool Suite, devices can be set up that are programmed and monitored using networks that
mirror the devices setup in the actual network.

« Devices can be grouped into serial, TCP Terminal Server, and Ethernet networks.

« Networks can be setup by geographic region, by customer, or whatever grouping that helps
identify the devices.

Each network has its own set of devices and configuration settings to connect to the devices within
it.

These applications in Tool Suite use networks:
« Configuration Application (on page 38)

« Networks defined in this application are shared with the Network Diagnostics
application.

« Network Diagnostics Application (on page 68)
« Networks defined in this application are shared with the Configuration application.

For more information, see:

« Create Configuration and Network Diagnostics Networks (on page 26)

« Configure Network Settings (on page 28)

« Delete Devices From Networks (on page 31)

« Export Networks (on page 32)

« Import Networks (on page 36)

« View Networks (on page 37)
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4.1. Create Configuration and Network Diagnostics Networks

Setup a network prior to configuring serial or Ethernet devices in the Configuration Application (on
page 38) or running diagnostics in the Network Diagnostics Application (on page 68).

Tool Suite supports multiple networks and network types that can run simultaneously.

Important!: The TCP terminal server network is only useful in the Network Diagnostics application
to gather diagnostics for a serial network through a TCP/IP connection to a terminal server.

4.11.
1.

o ok wbd

ok~ w0

Create a Serial Network (on page 26)
Create a TCP Terminal Server Network (on page 26)
Create an Ethernet Network (on page 27)

Create a Serial Network

In either the Configuration or the Network Diagnostics application, click Add in the
Datastore section of the ribbon to open the Add Network window.

In the Network Name text box, enter a name that identifies the network's purpose.
Optional: In the Company field, enter a company name associated with the network.
Click Next.

Click the Network Type list box arrow and select Serial.

If creating a network in the Configuration application, click Finish to save the network to
the database.

Note: If creating a network in the Network Diagnostics application, click Next and continue
with the next step.

Optional: In the Are you using 1.4 GHzfield, select Yes if there are any 1.4 GHz devices
in the network.
If not, leave the field set to No.

In the Com Port field, select the port the device is connected and click Next.
Click Finish to save the network to the database.
For additional network options, see Configure Network Settings (on page 28).

. Create a TCP Terminal Server Network

In either the Configuration or the Network Diagnostics application, click Add in the
Datastore section of the ribbon to open the Add Network window.

In the Network Name text box, enter a name that identifies the network's purpose.
Optional: In the Company text box, enter a company name associated with the network.
Click Next.

Click the Network Type list box arrow and select TCP Terminal Server.

LUMOO30AB Rev Oct-2019 Page 26 of 114 Copyright© 2019 FreeWave

This document is subject to change without notice. This document is the property of FreeWave Technologies, Inc.
and contains proprietary information owned by FreeWave. This document cannot be reproduced in whole orin

part by any means without written permission from FreeWave Technologies, Inc.



4. Network Files and Settings

Tool Suite
User-Reference Manual

4.1.3.

o gk wbd

Note: If creating a network in the Network Diagnostics application, click Next and continue
with the next step.

Inthe IP Address field, enter the IP address of the terminal server used to read the
network.

In the Port text box, enter the port number on the terminal server used to read the network
and click Next.

Click Finish to save the network to the database.
For additional network options, Configure Network Settings (on page 28).

Create an Ethernet Network

In either the Configuration or the Network Diagnostics application, click Add in the
Datastore section of the ribbon to open the Add Network window.

In the Network Name text box, enter a name that identifies the network's purpose.
Optional: In the Company field, enter a company name associated with the network.
Click Next.

Click the Network Type list box arrow and select Plus Ethernet.

If creating a network in the Configuration application, click Finish to save the network to
the database.

Note: If creating a network in the Network Diagnostics application, click Next and then
click Finish to add the network to the database.

For additional network options, Configure Network Settings (on page 28).
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4.2. Configure Network Settings

« The network's settings must be defined before connecting devices to the network.
» The network settings provide Tool Suite with the information it needs to connect to the

devices in the network.

Procedure

1. Ineither the Configuration application or the Network Diagnostics application, in the
Networks section of the ribbon, select the network to configure settings in.

2. Inthe Network Title ribbon, on the Options menu, select Network Settings.
The Network Settings window opens.

3. Complete these settings for the network:

Field Description
N Enter an identifying name for the network.
ame

If this field is left blank, the network name is Default Network.

Company Optional: Enter the company name associated with the network.
Enter the network type (serial or TCP).
1. If setting a serial or TCP network set the COM port or whether

1.4 GHz radios are in use in the network.
Interface

Polling Interval (ms)

2. Make the necessary changes and click Update in the Change

Interface window before returning to the Network Settings
window.

Enter the amount of time Tool Suite waits between each time it
pools the radios.
« The default Polling Interval is:
o 200 ms for Serial and TCP/IP networks and
o 500 ms for Ethernet networks.
« To poll automatically when a polling interval has completed,
select the Auto check box.

« See Recommended Polling Intervals (on page 30) for intervals
based on whether serial Repeaters are used in a network.
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Field Description

Select from one of these polling modes:

« Discovery - During the first diagnostic run of a new network and
to discover radios more quickly, set the polling mode to
Discovery to allot 9 out of 10 polls to discovering new radios in
the network, and 1 out of 10 polls to populating settings

information.
Polling Mode « This is the default mode when a new network is added.
« Discovery mode is not available for Ethemet networks.

« Sequential - After all radios have been discovered in the
network, change to Sequential mode.

« This mode allots 1 out of 10 polls to discovering new radios
and 9 out of 10 polls to populating settings information.

Select the amount of time Tool Suite waits before clearing data for
the specified network.

To keep the history data intact, select the Exclude History check
box.

Clear Diagnostics After

Enter any additional information about the network that is not

Notes highlighted in the settings.

4. Click Update to change the network settings.
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4.2.1. Recommended Polling Intervals
The default Polling Interval field setting is 200 ms for serial and TCP/IP networks, and 500 ms for Ethernet networks.
This table provides recommended polling intervals if the network includes serial Repeaters.

Default Minimum Repeaters

Network . . 1 Repeater 2 Repeaters Add 50 ms for each
Type Polling Polling LCTLCT 03 (add 50 ms) (add another 50 ms) additional Repeater
yp Interval Interval in Master P

Serial 200 ms 100 ms 100 ms 150 ms 200 ms 250 ms

TCP/IP 200 ms 100 ms 100 ms 150 ms 200 ms 250 ms

Ethernet*® 500 ms 100 ms 100 ms 150 ms 200 ms 250 ms

455 MHz 200 ms 300 ms 300 ms 600 ms 600 ms Not supported
[ Note: * In Ethernet networks, customer data is not given polling priority over diagnostic data. ]
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4.3. Delete Devices From Networks

Devices can be removed from a defined network without deleting the network and the network
settings. All devices and settings associated with a network, the network name, and any stored
diagnostic data can be deleted.

4.3.1. Delete an Individual Device from a Network

1. Ineither the Configuration application or the Network Diagnostics application, in the
Networks section of the ribbon, select the network to change.

2. Select the device to delete.
3. Right-click and select Delete.
4. Click Yes at the prompt to delete the device from the network.

4.3.2. Delete All Devices from a Network

1. In either the Configuration application or the Network Diagnostics application, in the
Networks section of the ribbon, select the network to change.

2. Inthe Network Title ribbon, on the Options menu, select Clear Network.

st
Right-click in an empty area in the tree view and select Clear Network.

3. Click Yes at the prompt to remove all the devices from the network.

4.3.3. Delete a Network

1. In either the Configuration application or the Network Diagnostics application, in the
Networks section of the ribbon, select the network to delete.

2. Inthe Network Title ribbon, on the Options menu, select Remove Network.

st
Right-click in an empty area in the tree view and select Remove Network.

3. Click Yes at the prompt to remove the network and all its data from Tool Suite.
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4.4. Export Networks

Use the Export functions to save a network data for transferring to a different Tool Suite
instance, or for viewing in a spreadsheet or database.

Important!: If there are multiple networks to export, they must be exported individually.

Datain a network in Tool Suite can be exported to one of these file types:

» Exporta FreeWave Network (.fwn) (on page 32)

« Exporta Network Settings Report (.csv) (on page 33)

« Exporta FreeWave Network Design (.fwt) (on page 33)

o Export Network Data to a SQL Server Database (.fwn) (on page 33)

Export a FreeWave Network ( )

[ Note: See Export a FreeWave Network (.fwn) (on page 33).

« Inthe Configuration Application, this exports the settings for the discovered and template
devices in a network that can be imported into another Tool Suite instance.

\LE)
""' Use this option to make a copy of a network file and then import it to use as a base for a

different network.

« Inthe Network Diagnostics Application, this exports the network file, the historical
diagnostic data, and the Path View into the network.

« Use the exported network configuration file to:

Load an existing radio configuration when radios are added to an existing network.

Reload the configuration of any radio in the network when replacing a failed or damaged
radio.

Send the exact network configuration to someone for review or troubleshooting.
Ensure the network configuration is always available at the Master radio site.

If you need to program a radio in the network, you have the needed configuration files at
hand.

Ensure there's always a saved version of the latest configuration settings for the network.
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Export a Network Settings Report ( )

[ Note: See Export a Network Settings Report (.csv) (on page 34). ]

« Inthe Configuration Application, this exports the settings for the discovered devices in the
network to afile that is opened in a spreadsheet application.

« Inthe Network Diagnostics Application, this exports the network file, the historical
diagnostic data, and the Path View information to a file that is opened in a spreadsheet
application.

« Viewing the network data in a spreadsheet can offer better clarity about settings across
the network.

Export a FreeWave Network Design (.fwt)

[ Note: See Export a FreeWave Network Design (.fwt) (on page 34).

« Exports the virtual network map in the Network Design tab of the Configuration
application that can be imported into another Tool Suite instance.

V1LY
=~ Use this option to make a copy of a Network Design and then import it to use as a base
@ for a different network.

Export Network Data to a SQL Server Database ( )

[ Note: See Export Network Data to a SQL Server Database (.fwn) (on page 34).

Important!; Read/Write permission to the server is required and the server must be accessible to
Tool Suite.

4.4.1. Export a FreeWave Network ( )

1. Ineither the Configuration Application or the Network Diagnostics Application, in the
Networks section of the ribbon, select the network to export from.

2. Inthe Network Title ribbon, on the Options menu, select Export > FreeWave Network
File.

VL
"‘"' Right-click in an empty area in the tree view and select Export > FreeWave Network
File.

3. If exporting a network file from the Network Diagnostics application, enter the date range
of the historical diagnostic data to include in the export and click Export.
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Example: To see historical data for the last month, enter the first and last days of that month
in the corresponding fields.

4. Optional: Select the Exclude Diagnostic History check box to complete the export
without any historical diagnostic data and click Export.

5. Inthe Export Network window, select the directory location to save the file in.

6. Inthe File name text box, enter the file name and click Save.
The file is saved in the directory location with a extension.

4.4.2. Export a Network Settings Report ( )

1. Ineither the Configuration Application or the Network Diagnostics Application, in the
Networks section of the ribbon, select the network to export from.

2. Inthe Network Title ribbon, on the Options menu, select Export > Network Settings
Report.

\ 1LY
““' Right-click in an empty area in the tree view and select Export > Network Settings
Report.

3. Inthe Export Network window, select the directory location to save the file in.

4. Inthe File name text box, enter the file name and click Save.
The file is saved in the directory location with a extension.

4.4.3. Export a FreeWave Network Design (.fwt)

1. Inthe Configuration Application, in the Networks section of the ribbon, select the network
to export from.

2. Inthe Network Title ribbon, on the Options menu, select Export > FreeWave Network
Design.

SR
Right-click in an empty area in Network Design and select Export > Design.

3. Inthe Export Network window, select the directory location to save the file in.

4. Inthe File name text box, enter the file name and click Save.
The file is saved in the directory location with a extension.

4.4.4. Export Network Data to a SQL Server Database ( )

1. Ineither the Configuration Application or the Network Diagnostics Application, in the
Networks section of the ribbon, select the network to export from.

2. Inthe Network Title ribbon, on the Options menu, select Export > SQL Server DB.
NT
Right-click in an empty area in the tree view and select Export > SQL Server DB.
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3. Inthe Database Connection Form window, complete this information about the SQL
Server database to save the network data from:

Field Description

Enter the location of the server that runs the SQL database to save

the network data from.
Database Server « This database must be within the IT network.

« The computer must have access to the location.

Read Only

« The network datais saved to a table in the SQL Server database
Database Name called FreeWaveNetwork.
« Ifthe table already exists in the database, when you export Tool
Suite adds lines to the existing table.

Select this check box to use the Windows user name and password
to access the SQL Server database.

Use WiDdO\_NS Note: If the database access credentials are different from

Authentication the Windows user name and password, do not select this
check box and use the Data User Name and Password
fields.

Enter the user name to access the server in the Database Server
field.

Enter the user password to access the serverin the Database
Server field.

Database User Name
Password

4. Click Test Connection to verify access to the database and that the entered user name
and password are correct.

« If Tool Suite can connect to the database, a Success message appears.
« If Tool Suite cannot connect to the database, an error message appears.

« Verify that the information entered in the Database Connection Form window is
correct and the server is running and test the connection again.

5. Click OK to export the network data to the SQL Server database.
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4.5. Import Networks
Use a FreeWave network file exported from Tool Suite to import the content of that network.
These file types can be imported:

« FreeWave - A file that was exported from Tool Suite v2.0.1.2 and earlier.

o FreeWave - A file that was exported from Tool Suite v2.2 and later.

o FreeWave - A file that was exported from the Network Design
tabin Tool Suite.

. - A file that was exported from the FreeWave EZC onfig application,
which preceded Tool Suite.

. - A network design file that was exported from the
FreeWave Comm Control application, which preceded EZConfig and Tool Suite.

. - A comma separated values ( ) file saved from a

spreadsheet application such as Microsoft Excel.

« These files must be formatted in this order: Serial Number, Name, and if applicable, IP
Address.

« Ifthefileis notin this format, an error is received when importing the file.

Important!: Ethernet networks only have the option to import Tool Suite and Comma
Separated Value file types.

Procedure

1. In either the Configuration application or the Network Diagnostics application, click
Import in the Datastore section of the ribbon to display the Add Network window.

2. Click the Options list box arrow in Network Title ribbon and select Import
3. Select the file type to import.

\LE)
=" Select Import from the Datastore section of the ribbon to import a Tool Suite v2.2 and
later file type ( )-

4. Inthe Import window, locate the file to import and click Open to import the file.
Tool Suite processes the file and opensiit.

5. Access the network from either the Configuration Application (on page 38) or
Network Diagnostics Application (on page 68).
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4.6. View Networks

« You can view a single network at a time. When you open a network to view in one
application, that network is also displayed in the other applications that use networks. For
example, if you open Network A in the Configuration application, if you move to the
Network Diagnostics application, Network A is open and displays in that application as well.

1. Ineither the Configuration or the Network Diagnostics application, click the list box
arrow in the Networks section in the ribbon.

2. Select the network to view.
The selected network appear in the application.

Note: Networks are grouped into Serial and Plus (Ethemnet) groups.
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5. Configuration Application

Use the Configuration application to program parameters on devices in the network and to:

» Use the Devices Tree (on page 40) to define templates that contain the settings to send to a
device.

» Create Network Designs (on page 52) diagrams that are a virtual version of the device
network.

» Define Device Parameter Settings (on page 46)
« Update a Device to the Latest Firmware Version (on page 63)

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.
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Click Configuration in the Applications pane. Figure 18
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Figure 18: Applications > Configuration
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5.1. Devices Tree

Tool Suite maintains a database of all radios that are read, programmed, or in some way
manipulated in the software.

« This database is used to check settings for a defined device without being connected to the
device.

« View the devices stored for a selected network in the Devices tab.

« The devices in the network appear in a tree format, similar to directories in Windows® File
Explorer.

In the Devices tab, devices are grouped into one of these views:

o Discovered Devices - Lists devices that have a serial number.

« Adevice is found when it is read through the Network Diagnostics application or
programmed in the Configuration application.

» Template Devices - Lists any radio created manually through the template wizard and
EZConfig imported files.

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

« To change between the two views, click the corresponding accordion button at the bottom
of the pane. Figure 19

« To hide or show the accordion buttons, click the arrow at the bottom of the window pane
and select which buttons to hide or show.
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Devices | Metwork Design

Template Devices

= 6 éNetwork
P-CR

B 1.3 GHz P-Series
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B FGR 900 MHz IO Slave
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B IM 24 GHz Series

MNew Base
E D Serial Base [4422PC]

Mew Expansion
Expansion Module [4422F]

Discovered Devices (7)

Template Devices (7)

Figure 19: Device tab - Accordion button

After Tool Suite successfully reads a device (after clicking Read Radio or Read Serial Base),
the list updates to include the read device’s serial number, name, and a symbol to indicate the
operation mode:

. m - Indicates a Master in the network.
. e - Indicates a Slave in the network.

o A\ _|ndicates a Repeater in the network.

. a - Indicates a Serial Base in the network.

Note: Tool Suite refreshes the right side of the window to show the selected device's settings.
Selecting a device listed in the Discovered Devices or Templates view refreshes the Device
Information and other settings for that selection.
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5.1.1. Add Template Devices to the Network

Use templates to define a device in the network.

« Settings in a template are defined and then used to program all the radios in the network

with that configuration.

Templates save time by not having to define each individual device in the network if the
devices share the same settings and helps to ensure that devices that require the same
settings across the network are programmed identically.

A template for a device can be added to the Device tree, which adds it to the network
database for any network type.

« The device is added with the factory default settings.

« This feature functions as a single radio template and is added to the Template Devices
view in the Device tree.

Add a Radio Template to the Device Tree

1.
2.

&

6.

In the Applications pane, click Configuration to open the Configuration application.

In the Networks section of the Configuration ribbon, select the network to add a device
to.

Right-click in a blank area of the Device tree and select Add > Radio Template.
In the Name text box, enter a name to identify this device.
Click the Radio Type list box arrow and select the type of device to add to the network.

Note: The lists includes all the supported devices for the network type.

Click Add to add the device to the Device tree.

Add a Serial Base Template to a Serial Network Device Tree

1.
2.

s

In the Applications pane, click Configuration to open the Configuration application.

In the Networks section of the Configuration ribbon, select the network to which you want to
add a device.

Right-click in a blank area of the Device tree and select Add > Serial Base Template.
In the Name text box, enter a name to identify the base.

Click the Module Type list box arrow and select the type of serial base to add to the
network.

Click Add to add the device to the Device tree.
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5.1.2. Filter Devices in the Device Tree
Filter the contents of the tree to view specific devices in a large network

and only want to see devices in the tree of a certain modem mode you can filter the contents of the
tree to display only those devices.

For example, if you only want to see the Slave devices.

[ Note: Devices can be filtered in the Network Design view. ]

1. Inthe Applications pane, click Configuration to open the Configuration application.
2. Inthe Networks section of the Configuration ribbon, select the correct network.
3. Click the Filter menu in the Network Title ribbon and select the device type to view.

[ Note: Select Show All to view all devices. ]

5.1.3. Organize Devices in Folders in the Device Tree

If the network contains a large number of devices, use folders in the Device tree to organize the
network.

Example: Create folders to store like devices together, or you might choose to organize the network
by geographic region.

1. Inthe Applications pane, click Configuration to open the Configuration application.
2. Inthe Networks section of the Configuration ribbon, select the network to add a folder to
the Device tree.

3. Right-click in a blank area of the Device tree and select Add > Folder.
A new folder is added to the tree.

4. Right-click the folder in the tree and select Rename and enter a name that describes the
content of the devices in the folder.

5. Tomove the folder in the tree, select the folder and drag and drop it to the correct location in
the tree.

6. Tomove devices in to the folder, select the device and drag and drop it onto the folder.

5.1.4. Program Devices from the Device Tree

When changes are defined for a device in the network in the Configuration application, they can
be sent to the device when it is connected to the computer running Tool Suite. The device can
also be returned to its factory default settings.

Note: For radios in a Terminal Server network, it is not currently possible to read a serial radio in the
Configuration application connected locally to the computer running Tool Suite.

The TCP terminal server network is only useful for network diagnostics where you want to gather
diagnostics of a serial network through a TCP/IP connection to a terminal server.
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Programming options are located above the tabs in the main Configuration application window
and appear when Tool Suite is reading a device. Figure 20

Program vy Default WAl

Figure 20: Programming Options

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

Procedure
1. Inthe Applications pane, click Configuration to open the Configuration application.

2. Inthe Networks section of the Configuration ribbon, select the network that contains the
devices to program.

3. Connectto the device and click Read Radio to poll the device for its settings.
4. Make changes to the settings, as necessary.
5. Inthe Network Title ribbon, select one of these programming options to send the settings

to the device:
Programming s
Options Description
Sends all the settings to the device, even if no changes have been made
to any settings.
All Note: If programming an Ethernet device, the settings can be

sent to another device in the network.
Enter that device's IP address when prompted.

\ J

Sends only the settings that have changed.

-

Important!: The Quick programming option is only available for
Quick changes made in the current session.

If Tool Suite is closed or a different device is selected, the
Quick option is no longer applicable.

\ J

Sends the factory default settings for all parameters to the device.

Default Answer Yes at the prompt to set the radio back to its factory default
settings.

Note: When the device is programmed, the device's Carrier Detect (CD) LED shows Solid
Green = and the Clear to Send (CTS) LED shows Solid Red (Bright) = .
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5.1.5. Read Current Settings From a Device

A device can be polled for its current parameter settings. Upon a successful read of a device, the
Device tree updates to include the device’s serial number, name, and a symbol to indicate the
operation mode. Tool Suite also refreshes the right side of the window displaying the device
settings. Selecting a device listed in the Discovered Devices or Templates view refreshes the
Device Information and other settings for that device.

Note: If an older version of firmware is loaded that Tool Suite does not support, the software
prompts a launch for EZConfig to read the device's settings.

1. Connect the device to the computer using either the serial port or the diagnostics port and
open Tool Suite.

2. Inthe Applications pane, click Configuration to open the Configuration application.

3. Inthe Networks section of the Configuration ribbon, select the network to add a device
to.

4. Ifthe device is serial, verify the correct COM port is selected in the Com Port field.

Note: To find the correct port on the computer, look in the Windows® Control panel under
System > Hardware > Device Manager >Ports.

« Tool Suite pulls its COM port settings from the Windows® operating system when
Tool Suite is opened.

« Ifthe COM port was configured after opening Tool Suite, or a device was connected to
Tool Suite after opening the application, the application might need to be closed and
reopened to select the correct COM port.

[ Important!: If a COM port is not configured in Windows®), it is not available in Tool Suite. ]

5. Ifthe device is an Ethernet device, verify the correct IP address for the device is entered in
the IP Address text box.

6. Click Read Radio to read the settings from the device that is currently connected or
click Read Serial Base if reading the settings from a Serial Base device.

« Ifreading an Ethernet device, a prompt appears to enter the device's password if the
password has changed since the last time the device was read from the current
instance of Tool Suite.

« Ifreading a Serial Base with Expansion Modules in a stack, Tool Suite reads the Serial
Base plus all Expansion Modules connected in the stack.

« A stack consists of one I/O Expansion Serial Base or serial device (e.g., FGR2-|0-
IOE) and up to 15 Expansion Modules (e.g., IOEX-4422).

Note: If reading a serial device's settings using the diagnostics cable, the device is placed
into Setup mode automatically and all three LEDs on the device turn Solid Green

If reading a serial device's setting using the serial port, Tool Suite prompts to place the
device into Setup mode before it can read the settings.
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5.2. Device Parameter Settings

See:

The serial or Ethernet network type determines the device templates that can be added to
the network.

Each set of devices has a set of parameters to configure and then send to the device.

The parameters are grouped together in tabs that appear in the Configuration
application's main pane.

Note: The template parameter settings in a serial or TCP network are identical.

Each device contains a different set of tabs and parameters; however, most devicesin a
serial network contain the same parameter settings and most devices in an Ethernet
network contain the same parameter settings.

In addition, the mode assigned in the Modem Mode field in the Operations Mode tab can
display a different set of tabs.

Note: The tab names correspond to the menus as they appear in Setup Terminal and other
terminal emulators.

These sections provide a brief overview of the contents of each tab in the different network
types.

For details about how the parameters apply to the connected device and recommended
values for each, refer to the documentation for that device.

Note: Parameters that appear with a double asterisk (**) are parameters that must be the
same for all devices across the network.

Ethernet Device Parameter Tabs (on page 47)
I/0 Serial Base and I/O Expansion Device Parameter Tabs (on page 49)
Serial / TCP Terminal Network Device Parameter Tabs (on page 50)
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5.2.1. Ethernet Device Parameter Tabs
The parameters for Ethernet network devices are shown here: Figure 21

HT-slave [284-5901] Program woi Default WAl

Device Information | IP Setup | Serial Setup 1 | Call Book | Serial Setup 2 | Radio Setup | Security SMMP  RMS Tools 4 F ¥

Figure 21: Ethernet Device Parameter Tabs

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and
Firefox®.

This table provides an overview of the contents of each tab.

Note: For details about how the parameters apply to the connected device and recommended values
for each, refer to the documentation for that device.

Ethernet Device Parameter Tabs

Tab Description

Includes basic device identification information such as the device name,

. ] model number, and serial number.
Device Information ) o o ) ) . )
Common diagnostics information is also available on this tab if reading a

device.

Contains communication information such as the |P address and default
Gateway address for the device.

IP Setu
g Important!: Check with the Network Administrator before

changing any settings on this tab.

Contains data settings for serial port 1 on the device.
« These settings need to match the serial device connected to this port.

Serial Setup 1
« Serial ports 1 and 2 are independent of each other; they can have

different baud rates, parity, protocol, etc.
Includes:
« the call information to incorporate up to 10 FreeWave radios,
« designate 1 to 4 Repeaters for use with each radio, and
« designate which specific Endpoint the Gateway calls, by serial

Call Book
number.
Important!: The Call Book is required in Point-to-Point networks.
Itis NOT recommended in Point-to-MultiPoint networks.
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Ethernet Device Parameter Tabs

Tab Description

Contains the data settings for serial port 2 on the device.

« These settings need to match the serial device connected to this port.

« Serial ports 1 and 2 are independent of each other; they can have
different baud rates, parity, protocol, etc.

Serial Setup 2

Contains all the settings regarding general radio setup such as Operation

Rauigle s Mode and transmission characteristics.
Contains security settings such as RADIUS authentication, passwords,
and encryption keys.

Security

Note: In Release v2.11.2, MAC filtering is not supported in Tool
Suite.

Contains all SNMP management features, such as the SNMP version.

« All of the SNMP manageable objects for the FreeWave Ethernet
SNMP devices are contained in a single MIB file called FREEWAVE-
TECHNOLOGIES-MIB.

« Contact FreeWave Technical Support (on page 7) to request this file.

Contains settings for enabling a Redundancy Master Station (RMS) and

RMS settings for the main and back up devices.
Users Contains the group permissions to view and change settings.
Tools Contains free-form fields used to define site information.
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5.2.2. 1/0 Serial Base and /O Expansion Device Parameter Tabs
The parameters for I/O Serial Bases and Expansion Modules are shown here: Figure 22

402-653-3112

Device Information | (0) Universal Channels | (1) Input Channels | (2) Isolated Digital Inputs | {3)Isolated Digital Qutp 4 P &

Program o Default WAl

Figure 22: 1/0 Serial Base and I/0 Expansion Device Parameter Tabs

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and

Firefox®.

This table provides an overview of the contents of each tab.

Note: For details about how the parameters apply to the connected device and recommended values
for each, refer to the documentation for that device.

1/0 Serial Base and I/0O Expansion Device Parameter Tabs

Tab

Description

Device Information
(0) Universal Channels

(1) Input Channels

(2) Isolated Digital
Inputs

(3) Isolated Digital
Output

(4) Stack Settings

Includes basic device identification information such as the device
name, model number, and serial number.

Corresponds and programs channels 1, 2, 3, and 4 of the I/O Serial Base
and Expansion Module devices.

Corresponds and programs channels 5, 6, 7, and 8 of the I/O Serial Base
and Expansion Module devices.

Corresponds and programs channels 9 and 10 of the I/O Serial Base and
Expansion Module devices.

Corresponds and programs channels 11 and 12 of the I/O Serial Base
and Expansion Module devices.

Applies to the I/O Serial Base and programs how the stack
communicates with external Modbus devices.
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5.2.3. Serial /| TCP Terminal Network Device Parameter Tabs
The parameters for most devices available in a serial and TCP terminal devices are shown here:

Figure 23

Grand Master [926-4604]

Device Information | (0) Operation Mode | (1) Baud Rate | (2) Call Book | (3) Transmission Characteristics | {5) MultiPoint Parameters | (6) TDMA Settings

Program www Default

Figure 23: Serial / TCP Terminal Network Device Parameter Tabs

Note: The images in this document and/or procedure are for Windows® 7 and/or Windows® 10 and

Firefox®.

This table provides an overview of the contents of each tab.

Note: For details about how the parameters apply to the connected device and recommended values
for each, refer to the documentation for that device.

Serial / TCP Terminal Network Device Parameter Tabs

Tab

Description

Device Information

(0) Operation Mode

(1) Baud Rate

(2) Call Book

Includes basic device identification information such as the device name,
model number, and serial number. Common diagnostics information is
also available in this tab if you are reading a device.

Operation Mode defines the device function (e.g., Master, Repeater, or
Slave).
« FreeWave radios operate in a Master to Slave configuration.

« Forradios to operate together, proper communication setup is
required.

« Ethernet options for Ethermet devices are also configured in this tab.

Includes communication settings between the radio and the device it is
connected to.

Includes the call information to incorporate up to 10

« FreeWave radios, designate one to four Repeaters for use with each
radio, and designate which specific Slave the Master calls, by serial
number.

« The Call Book is required in Point-to-Point networks; however, is not
recommended in Point-to-MultiPoint networks.
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Serial / TCP Terminal Network Device Parameter Tabs

Tab Description

Includes parameters that change how a radio sends data (e.g., frequency
keys and low power settings).

« Many of the parameters in this tab must be maintained across the

(3) Radi network for proper functionality.
adio

Transmission
Characteristics

« The options in this tab determine the RF characteristics of the
network.

« Default settings are NOT recommended for the network critical
settings.
« However, an understanding of the settings in this menu is
recommended prior to changing any of the values.

Includes settings used to control how data is handled in situations
requiring retries and the settings to control the behavior of a MulitPoint
Slave or Repeater.

« When installing MultiPoint networks it is important to do some initial

(5) MultiPoint planning.

Parameters « Unlike Point-to-Point networks, a Point-to-MultiPoint network
requires several parameters to be set consistently on all radios in the
network.

o This includes RF Data Rate, Min and Max Packet Size, Network
ID, and Frequency Key.

Includes Time Divisible Multiple Access (TDMA) settings, which allow
radios to complete various operations in specific time slots.

« This option is used only for peer-to-peer communications or when
applications are very time specific and must be enabled on the device

(6) TDMA Settings at the factory.
« Ifitis not enabled at the factory, this tab does not display.

« For additional information about TDMA, Contact FreeWave Technical
Support (on page 7).
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5.3. Network Designs

Use the Network Design feature to design and configure a virtual network prior to programming
devices.

Create network designs for either serial or Ethernet networks.

The Network Design provides a visual representation of the devices connected in the
network.

Use the Network Design feature without previously adding devices to a network using the
Devices tree.

Connect Devices to Master Templates in Network Designs (on page 53)
Create an Ethernet Network Design Using the Design Wizard (on page 56)
Create a Serial Network Design Using the Design Wizard (on page 58)
Edit Settings for Devices in Network Designs (on page 59)

Export and Import Network Designs (on page 60)

Print Network Designs (on page 60)

Program Devices from Network Designs (on page 61)

Remove Devices From Network Designs (on page 62)

Rename Devices in Network Designs (on page 62)
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5.3.1. Connect Devices to Master Templates in Network Designs

After creating a template for a Master radio in the network, the next step is to connect Slaves,
Repeaters, and Slave/Repeaters for programming to the Master in the network design. Devices
connected to the Master inherit the master's settings.

« Connect a Serial Device (on page 53)

« Connect an Ethernet Device (on page 55)

Connect a Serial Device
1. Inthe Applications pane, click Configuration to open the Configuration application.

2. Inthe Networks section of the Configuration ribbon, select the serial network to design
and click the Network Design tab.

3. Right-click the Master icon and select Connect.
4. Selectthe modem mode of the device to attach. Figure 24

Devices | Metwork Design

FGR Master
FGR 900 MHz Series
K .
W Program Settings
R
dit Settinng
Met] Edit Settings...
Ma: | Rename..
'-E'=! Connect ¥ 6 Slave
W PRemove :_1 Repeater

A Slave/Repeater

Figure 24: Connect > Select Modem Mode Options

5. Inthe Name field, enter a name that identifies the device.
6. Clickthe Radio Type drop-down list and select the device type.
All possible types that can connect to the Master are listed.

7. Click Add.
An icon for the device appears with the inherent critical settings. Figure 25
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FGR Master 9
FGR 900 MHz Series Slave
Key: A ~™FGR 900 MHz Series
Rx: 0T 0 Key: A
MetID: 1839 Rc0TxF
Max: & Min: 9

Figure 25: Example: Device Icons

8. Optional: To connect another radio to a Repeater or Slave/Repeater, right-click the device
icon to add a connection to and repeat the Steps 1 to 7 to add the device.

Figure 26 is an example of a Repeater or Slave/Repeater Network.

9
FGR 900 MHz Series
Key: A
Rx: 0T F
FGﬂter A e
FGR 900 MHz Series Repeater Slave
Key: A FGR 900 MHz Series FGR 900 MHz Series
Re: 0 Tx: 0 Key: A RF: Disabled Key: A
Met IC: 1839 R 0T 1 Ra: 1T F
Mazx: & Min: 9
Slavefﬂﬁepeater g
FGR 900 MHz Series FGR 900 MHz Series
Key: B RF: Enabled Key: B
Fo: 0 Tox 2 Fo: 2 Tz F

Figure 26: Example: Repeater or Slave/Repeater Network

Note: If multiple Repeaters or Slave/Repeaters are connected, Tool Suite automatically
enables Repeater Frequency and assigns a unique frequency key for each subsequent
Repeater or Slave/Repeater connected.
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Connect an Ethernet Device

1. Inthe Applications pane, click Configuration to open the Configuration application.

2. Inthe Networks section of the Configuration ribbon, select the Ethernet network to
design and click the Network Design tab.
3. Right-click the Master icon and select Connect.
4. Select the modem mode of the device to attach. Figure 27
HTplus Master
HT+ 900 MHz Ethernet Series
Key W Program Settings
. Edit Settings..
Met I:
Max: 9 Rename..
I-E:l Connect 3 a Slave
% Remove i Repeater
Figure 27: Connect > Select Modem Mode Options
5. Inthe Name field, enter a name that identifies the device.
6. Clickthe Radio Type drop-down list and select the device type.
All possible types that can connect to the Master are listed.
7. Click Add.
An icon for the device appears with the inherent critical settings. Figure 28
HTplus Master e
HT+ 900 MHz Ethernet Series Slave
Key: 9 HT+ 900 MHz Ethernet Series
Rx: 0T 0 Key: 9
MetID: 1820 Roc: O Tx: F
Max: 9 Min: 1

Figure 28: Example: Device Icons

Note: One Slave node can be programmed for many radios. There is no need to connect
multiple Slaves together, when programming. Simply change the Radio Name when
prompted for the subsequent Slave(s) as you program them.

8. Optional: To connect another radio to a Repeater, right-click the radio to add a connection
to and repeat Steps 1 to 7 to add a Slave connection.
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5.3.2. Create an Ethernet Network Design Using the Design Wizard

Use the Create Network Design wizard to define an Ethernet network where a Master radio
connects to the other devices in the network design.

Note: When the Network Design tab is selected in a network, Tool Suite prompts to add a Master
using the Create Network Design Wizard.

Important!: A Plus Ethernet network MUST BE created before access to the Network Design
feature is available.

1. Inthe Applications pane, click Configuration to open the Configuration application.

2. Inthe Networks section of the Configuration ribbon, select the Ethernet network to
design.

3. Clickthe Network Design tab.

Note: If the Create Network Design wizard does not appear, right-click anywhere in the
Network Design pane and select Template Wizard.

4. Onthe Radio Type drop-down list, select the Gateway radio type and click Next.
5. Onthe Network Structure drop-down list, select the network type and click Next.

Note: As of Tool Suite version 2.8.5, Point-to-Point and TDMA network structures are not
supported in the Create Network Design feature.

6. When prompted, set these eight critical settings or accept the default settings and click
Next.

Important!: For radios to successfully communicate with one another in a network, these
critical settings that must be the same across all radios in the network.
Any Endpoint or Repeater connected to the Gateway template inherits these settings.

Setting Description
Subnet Mask Typically assigned by the Network Administrator.
Default Gateway Typically assigned by the Network Administrator.
Frequency Key Select from numbers 0 to 9 and letters Ato E.
Max Packet Size Select from numbers 0 through 9.
Min Packet Size Select from numbers 0 through 9.
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Setting Description
Select 115 kbps for a low RF data rate or 154 kbps for a high data
rate.

RF Data Rate
Note: Different rates are available if a high throughput device

is selected as the Master.

Master Tx Beacon Select from numbers 0 through 9.
Select from 0 through 4095.

Network ID Note: 255 enables the Call Book and disables the Network
ID.

Note: For more information regarding settings, see the user manual for the radio to configure.

7. Inthe Template Name text box, enter a name for the Gateway device template.
8. Click Finish to save the template.
After the initial creation of the Gateway, the radio template is complete.

A Master icon appears in the Network Design tab with the previously selected network
parameters. Figure 29

Devices | Metwork Design

HTplus Master
HT+ 900 MHz Ethernet Series
Key: 9
Ro: 0 Tz 0
Met ID: 1820
Max: 9 Min: 1

Figure 29: Network Design tab with Master Icon

Note: To connect devices to the master, see Connect Devices to Master Templates in
Network Designs (on page 53).
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5.3.3. Create a Serial Network Design Using the Design Wizard

Use the Create Network Design wizard to define a Serial network where a Master template
radio connects to the other devices in the network design.

Note: When the Network Design tab is selected in a network, Tool Suite prompts to add a Master
using the Create Network Design Wizard.

When creating Network Designs, the devices are applied to the current network that is selected.

If there is no unique network, the Network Design applies to the Default Network.

1. Inthe Applications pane, click Configuration to open the Configuration application.
2. Inthe Networks section of the Configuration ribbon, select the serial network to design.
3. Clickthe Network Design tab.

Note: If the Create Network Design wizard does not appear, right-click anywhere in the
Network Design pane and select Template Wizard.

4. Onthe Radio Type drop-down list, select the Master type and click Next.
5. Onthe Network Structure drop-down list, select the network type and click Next.

Note: As of Tool Suite version 2.8.5, Point-to-Point and TDMA network structures are not
supported in the Create Network Design feature.

6. When prompted, set these five critical settings or accept the default settings and click Next.
Important!: For radios to successfully communicate with one another in a network, these
critical settings that must be the same across all radios in the network.

Slaves, Repeaters, or Slave/Repeaters connected to the Master template inherit these
settings from the Master.

Setting Description

Frequency Key Select from numbers 0to 9 and letters A to E.
Max Packet Size Select from numbers 0 through 9.
Min Packet Size Select from numbers 0 through 9.

Select the RF data rate.

RF Data Rate Depending on the device, this could be a selection such as
Normal or High, or 1, 2, or 3.

Select from 0 through 4095.

Network ID Note: 255 enables the Call Book and disables the
Network ID.

7. Configure data port settings, which any connected Slave, Repeater, or Slave/Repeater
inherits, click Next.

LUMOO30AB Rev Oct-2019 Page 58 of 114 Copyright© 2019 FreeWave

This document is subject to change without notice. This document is the property of FreeWave Technologies, Inc.
and contains proprietary information owned by FreeWave. This document cannot be reproduced in whole orin
part by any means without written permission from FreeWave Technologies, Inc.



Tool Suite

5. Configuration Application User-Reference Manual

[ Note: For more information regarding settings, see the user manual for the radio to configure. ]

8. Inthe Template Name text box, enter a name that identifies the Master device.
9. Click Finish to save the template.
After the initial creation of the Master, the radio template is complete.

A Master icon appears in the Network Design tab with the previously selected network
parameters. Figure 30

FGR Master
FGR 900 MHz 5eries
Key: A
Roc: 0 Tz O
MetID: 1830
Max: & Min: 9

Figure 30: Network Design tab with Master Icon

Note: To connect devices to the Master, see Connect Devices to Master Templates in
Network Designs (on page 53).

5.3.4. Edit Settings for Devices in Network Designs
Devices added to a network design can be edited for each device's settings that were not
addressed during the wizard setup.
1. Inthe Applications pane, click Configuration to open the Configuration application.

2. Inthe Networks section of the Configuration ribbon, select the network to edit and click
the Network Design tab.

3. Right-click the device to change and select Edit Settings to show the parameter tabs.

Note: The same tabs appear with the same settings as on the Configuration main window
when the device was selected.

4. Make the necessary changes and click Update to save the changes.
Tool Suite prompts to select whether the setting changes affect just the selected radio or
all the radio templates in the virtual network.

5. Click Yes to apply the changes to all connected devices in the template,
No to apply the changes to only the selected device, or
Cancel to return to the Edit Settings window without applying the changes.

Tool Suite refreshes the devices with the changes.
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5.3.5. Export and Import Network Designs

Export a Network Design to use in another instance of Tool Suite.

[ Note: Network Design files have a extension. ]

Export a Network Design
1. Inthe Applications pane, click Configuration to open the Configuration application.
2. Inthe Networks section of the Configuration ribbon, select the network to export and click
the Network Design tab.
3. Onthe Options drop-down menu in the Network Title ribbon, select Export > FreeWave
Network Design.

LK

NS
Right-click in the Network Design window and select Export Design.

4. Select the location to save the file in, enter a file name, and click Save.

[ Note: The file can be sent in an email or added to an external drive. ]

Import a Network Design

1. Inthe Applications pane, click Configuration to open the Configuration application.

2. Inthe Networks section of the Configuration ribbon, select the network to import and click
the Network Design tab.

3. Ifa Network Design exists, right-click in the Network Design window and click Clear
Templates.

4. After the Network Design areais clear, right-click and select Import Design and select
the file to import.

5. After the file imports, right-click the device for programming and select Program Settings
while connected to the device to receive those settings

5.3.6. Print Network Designs
You can print a network design for review or to keep on file.
1. Inthe Applications pane, click Configuration to open the Configuration application.
2. Inthe Networks section of the Configuration ribbon, select the network to print and click
the Network Design tab.

3. Right-click in an empty area of the Network Design and select Print.
A print preview window with print options opens.

4. Selectthe printer to print to, make any printing adjustments as needed, and click Print.
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5.3.7. Program Devices from Network Designs
After the Network Design is complete, individual device settings can be programmed.

Important!: Verify the device to program is connected to the computer running Tool Suite with the
appropriate cable.

Procedure

1.
2.

In the Applications pane, click Configuration to open the Configuration application.

In the Networks section of the Configuration ribbon, select the network to program and
click the Network Design tab.

Right-click the device in the Network Design to program and select Program Settings.

In either the Radio Name text box or the Site Name text box for an Ethernet device, enter
the name to program to the device.

Click Program to send the settings and the name to the device.

[ Note: Entering a name is optional. The device can be programmed without entering a name.

| If programming an Ethernet device, send a new IP address by entering the IP address

MY inthe New IP Address field.
@ Enter the current IP address in the New IP Address field if the address remains the
- same.

A status bar appears while the device is being programmed. Figure 31

Programming Radio...

Frequency Zone

Figure 31: Status bar

« When the device is programmed, the device's:
o Carrier Detect (CD) LED shows Solid Green = and the
o Clearto Send (CTS)LED shows Solid Red (Bright) = .
« After programming is complete, the Network Design window opens.

« Foreach subsequent device in the network to program, connect the serial or diagnostic
cable to the radio for programming and repeat Steps 3 to 5.

Note: One Slave node can be programmed for many radios. There is no need to connect
multiple Slaves together in the Network Design when programming. Change the Radio Name
when prompted for the subsequent Slaves as you program them.
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5.3.8.

Remove Devices From Network Designs

A group of devices can be deleted or a single device can be deleted as long as it does not have
another device connected to it from a Network Design.

Example: If a Master or a Repeater is removed from the Network Design, all connected devices are
deleted as well.
If removing only a Slave or Endpoint that is at the end of a network, only that device is deleted.

1.
2.

3.
4.

5.3.9.

In the Applications pane, click Configuration to open the Configuration application.

In the Networks section of the Configuration ribbon, select the network to edit and click
the Network Design tab.

Right-click the device to delete and select Remove.
Click Yes at the prompt to complete the deletion.

Rename Devices in Network Designs

A device can be renamed after it's added to a Network Design.

1.
2.

In the Applications pane, click Configuration to open the Configuration application.

In the Networks section of the Configuration ribbon, select the network to edit and click
the Network Design tab.

Right-click the device and select Rename.

In the Name text box, enter the new name and click Update to save the change.
Tool Suite prompts you to verify the change.

Click Yes to proceed with the change.
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5.4. Update a Device to the Latest Firmware Version
Tool Suite can be used to upgrade the firmware on devices from a single location.

« If Tool Suite is connected to a device, and a new versions of firmware is available for that

device, an indication appears on the Device Information tab in the Configuration
application.

o The firmware releases available for the devices in the network are also visible.

Note: In Release v2.11.2, Tool Suite does not support over-the-air firmware upgrades or firmware
upgrades to Ethernet devices. is this true?

Powobd -~

In the Applications pane, click Configuration to open the Configuration application.
In the Networks section of the Configuration ribbon, verify serial networks are visible.
Select the network to upgrade.

In the Firmware section of the Configuration ribbon, click View Available.
A list of the latest firmware versions for Tool Suite supported products appears. Figure 32

Available Firmware

Model
L.3 GHz P-Series
L.3 GHz P-5enes (Autoslicer)
FGR 900 MHz Cathadic Protection
FGR 900 MHz IO Master
FGR 900 MHz IO Slave
FGR 900 MHz Senes
FGR 900 MHz Short Range
FGR2 900 MHz IO Slave
FGR2 900 MHz IO Slave (Enclosed)
FGR2 900 MHz Series
HT 900 MHz Series
12 2.4 GHz IO Slave
12 2.4 GHz Series
I 2.4 GHz Cathodic Protection

I 2.4 GHz Series

Close

Version

Settings

Wiew

3

.}

Figure 32: Example: List of Supported Products

5. Click View next to the firmware version to view the settings for the model in that version of

6. Connectto the device to upgrade.
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7. Inthe Firmware section of the Configuration ribbon, click Upgrade Radio.
8. Click Yes at the prompt to continue. Figure 33

FreeWave Tool Suite [¥|

& You are about ko perform a firmware upgrade of the connected radio,
‘EJ‘) This may take several minutes to complete,

Are you sure you wish ko continue?

| ves | [ Mo ]

Figure 33: Continue Upgrade Message

Tool Suite identifies and shows the firmware version that is loaded on the connected
device and the latest version of firmware available for that model. Figure 34

FreeWave Tool Suite Igl

\ir) This radio has Firmware version 2,662,

Tool Suite has 2,66z available.

Would you like to update the radio ko 2,662

| ves | [ ] ]

Figure 34: Upgrade Message for Specific Model

9. Click Yes to continue with the upgrade.
The system shows the progress of the firmware upgrade. Figure 35

Updating Radio...

Updating Firmware to 2.66z

Figure 35: Progress bar

A message appears when the update is completed.
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6. Local Diagnostics Application

The Local Diagnostics application presents a real-time snapshot of MultiPoint setups that
measure the signal-to-noise level of the device.

« This information may be read from a Slave, Repeater, or Slave/Repeater device.

» Use local diagnostic information to help direct a directional antenna of a Slave device by
tracking the signal and noise levels as the antenna is aimed back at the Repeater or Master.

Important!: To run Local Diagnostics set the connected device’s Diagnostics parameter (located
in the MultiPoint Parameters tab) to a value greater than O (zero).

« Run Local Diagnostic (on page 66)
« Stop aLocal Diagnostic (on page 66)
« Printthe Local Diagnostics Graph (on page 67)
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Click Local Diagnostics in the Application pane. Figure 36

Local Diagnostics a
P T R . b €3 L [ o | noise [ Mergin | %pov 0@
L I FREEWAVE

Connection Values

Applications

Configuration
&
Metwork Diagnostics
ey
@lﬁ-)- ‘
i

\ l')

Local Diagnostics

oA

Updates

‘—'—\nMarqm —— InSignal —+— InNoise —e— Receive % |

Available applications

Figure 36: Applications > Local Diagnostics

6.1. Run, Stop, and Print Local Diagnostics

The Local Diagnostics application presents a real-time snapshot of MultiPoint setups that
measure the signal-to-noise level of the device. It presents the data in both a graph form and with
values in a table above the graph.

6.1.1.
1.

4.

6.1.2.
1.

2.

Run Local Diagnostic

Click Local Diagnostics in the Applications pane to view the Local Diagnostics
application.

In the Port Speed field in the Local Diagnostics ribbon, select the speed of the port of the
device is connected.

Inthe Com Port field in the Local Diagnostics ribbon, select the COM port the device is
connected to.

Click Start in the Local Diagnostics ribbon to begin running the diagnostic.

Stop a Local Diagnostic

Click Local Diagnostics in the Applications pane to view the Local Diagnostics
application.

Click Stop in the Local Diagnostics ribbon.
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6.1.3. Print the Local Diagnostics Graph

1. Click Local Diagnostics in the Applications pane to view the Local Diagnostics
application.

2. Click Print in the Local Diagnostics ribbon to open a print preview of the graph.

3. To printthe graph, click the Printer icon in the upper left corner of the print preview window.
The document is sent to the default printer designated on the computer.
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7. Network Diagnostics Application

Network Diagnostics provides a place to view diagnostic data for all the devices connected to the
Master in the network in real time. It is not meant to replicate the functionality of an NMS system,
but rather is a tool that used for diagnostics and troubleshooting in the field.

-

Important!: The Network Diagnostics application is intended for occasional network monitoring or
troubleshooting, not for continuous, long-term collection of diagnostic data. Aggressive polling by the
Network Diagnostics application or polling during periods of heavy data traffic may cause
degradation in data throughput.

Tool Suite is not optimized for the collection and management of large amounts of diagnostic data
from continuous polling. Collection of excessive amounts of data results in overall performance
degradation in Tool Suite.

Polling multiple networks simultaneously is allowed but is NOT recommended. Depending on the
number and size of networks being polled, Tool Suite may experience performance degradation or
instability.

Review the Network Diagnostics Best Practices (on page 69) before using the application.

.

In this section about the Network Diagnostics application:
« Discovering and Reading Devices (on page 69)
« Path View (on page 72) and what displays in it.

« Usethe Alerts, Warnings, and Alarms (on page 74) to determine what flags a device has an
alert or warning.

« Runand View Network Diagnostics (on page 80) data.
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Click Network Diagnostics in the Applications pane to get started. Figure 37

Nework Dlagnosti .
Default Network
b (X~ =y i{;e"ﬂ‘\% = Y Yol
Start Add Import Verify F R E EWAVE
- Database
Netwarks Datastore
Applications €3 Default Network - COM1 5 Polling S/ Filter | Search ¥ Options
.\ Path View | Summary View
l_\ @ No radios have been defined.
Configuration
>
&
Mebwack Diagnastics

)

Network Diagnostics

Select a radio or network from the tree on the left.

Setup Terminal

o

Updates

[ Radio Count:0 Poller Status: Disconnected Last Rxx None <0> 4 View History

Figure 37: Applications > Network Diagnostics

7.1. Network Diagnostics Best Practices

Because there are several variables involved, FreeWave cannot provide a one-size-fits-all
recommendation for all settings when running Network Diagnostics. Each situation is different.
FreeWave does recommend these best practices for optimum network stability and performance,
as well as Tool Suite stability and performance:

« Use Network Diagnostics only for occasional monitoring or troubleshooting, not
continuously.

« Poll only one network at a time.
« Poll networks at times of low data throughput.
« Turn the polling host off or poll between scheduled SCADA polls.

« Increase polling intervals to reduce the number of diagnostic polls injected into the network
and reduce the amount of diagnostic data collected.

« Set networks to clear diagnostics after the shortest acceptable time interval.

7.2. Discovering and Reading Devices

To run diagnostics using the Network Diagnostics application, poll the network for the devices
that are available and the devices current settings.

« Discover Ethernet Devices (on page 70)
« Reading Ethernet Device Settings (on page 71)
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Note: Prior to running diagnostics for the network, define the network to diagnose. For more
information, see Create Configuration and Network Diagnostics Networks (on page 26).

7.2.1. Discover Ethernet Devices

To search for Ethernet devices available to add to the diagnostic network, you can run a discovery
for all devices available.

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the ribbon, click the drop-down menu select an Ethernet
network.

3. Inthe Options drop-down menu in the network title ribbon, select Discover Radios.
The Plus Radio Discovery window opens.

4. Click Search and select a length of time to automatically stop searching for devices.

5. Optional: Click Search again to stop searching before the allotted time.
Discovered devices in the network appear in the device list. Figure 38

= Plus Radio Discovery £3

Discovery Tools

—
AV 4
Search Add
10 mins Radios
Discovery
# Serial Number Name Firmware IPAddress Metmask Gateway Web Port

1 8849702 2,18 7/24/2009 192.168.112.237 255.255.255.0 192.168.111.1 80

Figure 38: Example: Discovered Device

6. Optional: Click Add Radios to add the devices listed to the diagnostic network.
7. Click Clear to clear the discovery list.
The added devices appear in the Path View for the network.

Note: For more information, see Path View (on page 72).
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7.2.2. Reading Ethernet Device Settings

When running diagnostics on an Ethernet network, poll all devices in the network for settings,
name, and firmware versions.

Note: Polling for a device's name and firmware version is only available on Ethernet devices running
firmware versions 2.18 and above.

Read an Ethernet Device for Settings

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select an Ethernet network.

3. Inthe Options drop-down menu in the Network Title ribbon, select Read > All Radios.
Tool Suite reads the settings from all Ethernet devices available in the network.

Read an Ethernet Device for its Name and Firmware Version

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select an Ethernet network.

3. Inthe Options drop-down menu in the Network Title ribbon, select Read >
Name/Firmware Version.

Tool Suite reads the name and current firmware version installed on all Ethernet devices
available in the network.
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7.3. Path View

The Path View tab shows a tree view of devices and their Master / Repeater / Slave hierarchy in
the network. The devices appear in the tree whether they were added manually or through a
discovery feature.

« The icons next to the devices help identify where they fall in the network hierarchy.
« The icon color indicates whether the device is in an warning or alarm status. Figure 39
o When the icon is blue, either:
« there are no alarms/warnings or
« allalarms/warnings have been acknowledged or cleared for this device.
« For more information, see Alerts, Warnings, and Alarms (on page 74).

Path View | Summary Wiew
= [ m9254534
[ Aau—asas

v] | ) 915-6846

Figure 39: Example: Alerts

The devices in the Path View appear with one of these icons:
. m - Indicates a Master in the network.

. 9 - Indicates a Slave in the network.

A
. A% _|ndicates a Repeater in the network.

. A - Indicates a Slave/Repeater in the network.
Each device in the Path View has a check box.

« When a device's check box is selected, the device gets actively polled when the network is
set to poll.

« Devices whose check box is not selected are excluded from polling.

« Allrelated devices linked to a Master are selected or unselected when the Master in the
hierarchy is selected or unselected.

« Use Ctrl + left-click to change the selection for a single device in the tree.
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7.3.1. Searching for Devices in the Network

In alarge network, use the Search option to locate the device in the Path View in the Network
Diagnostics application.

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to search.
3. Clickthe Search option in the Network Title ribbon.

4. Enter a device name or a serial number.

If searching in an Ethernet network, search by IP address of the device using the Enter an
IP Address field.

[ Note: Enter serial numbers without a dash. ]

o Astextis entered in the search fields, Tool Suite searches for devices that match the
search criteria and shows the matches in a list. Figure 40

« Select a matching device at any time to jump to it in the Path View.

], search | % Options

Enter a mame or serial number:
it 66
Ga41066

9841773
8545901

Figure 40: Example: Device Search

Note: If Tool Suite finds a single device that matches the entered search criteria, it jumps to
the device and highlights it in the Path View.
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7.4. Alerts, Warnings, and Alarms

When network diagnostics are run, Tool Suite polls the devices for the parameters described in
Parameter Definitions and Recommended Values (on page 90).

Use alert definitions to enter the parameters and settings to be visually notified about if the
condition occurs in the network.

Example: To have Tool Suite send and alert when a device's voltage goes above the recommended
limit, set up an alert as either a warning or alarm.

When diagnostics are run and devices are polled in the network, if a device has a parameter that

sends it into an alert or warning status, the device's icon in the Path View reflects the state of the
device, providing instant visual that a condition exists.

. “ - The device is in a Warning state.

. 6 - The device isin an Alarm state.

Note: If the device appears with a blue icon, it has no alarms or warnings or all alarms or warning
have been marked as acknowledged.
For more information, see Acknowledging and Clearing Alerts

Review each device with an alert state to analyze the details about the alert, the data received
during the poll of the device, and the time that poll took place. Use this information to help
troubleshoot the device's error.

Alerts

When reviewing devices in an alert state, acknowledge an alert so the device no longer shows an
alert state.

Note: Acknowledged alerts still appear in the list of alerts for a device in the Alerts tab.
They do not cause the device's icon to change color in the Path View.

« Acknowledge Individual Alerts on a Device (on page 75)
« Acknowledge All Alerts on a Device (on page 75)

o Clearan Alert (on page 75)

o Create Alert Reports (on page 76)

« Polling Devices With Alerts (on page 77)

« Setting Alert Definitions (on page 77)

« Showing Only Devices With Alerts (on page 79)
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7.4.1.
1.

7.4.2.

5.

7.4.3.

Acknowledge Individual Alerts on a Device

Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

In the Networks section of the Network Diagnostics ribbon, select the network to
acknowledge alerts.

Select the device that is an alert state and click the Alerts tab at the bottom of the main
window to view the list of alerts for device.

Select the check box in the Ack'd field next to the alerts to acknowledge.

Click Acknowledge Alerts.
The alert indicator for the device in the Path View is removed.

Note: The alerts remain in the Alerts list for the reference.

Optional: Clear an Alert (on page 75).

Acknowledge All Alerts on a Device

. Click Network Diagnostics in the Applications pane to view the Network Diagnostics

application.

In the Networks section of the Network Diagnostics ribbon, select the network to
acknowledge alerts.

Select the device that is an alert state and click the Alerts tab at the bottom of the main
window to view the list of alerts for device.

In the Options drop-down menu in the Network Title ribbon, select Alerts >
Acknowledge All Alerts.
The alert indicator for the device in the Path View is removed.

Note: The alerts remain in the Alerts list for the reference.

Optional: Clear an Alert (on page 75).

Clear an Alert

After the condition causing an alert is resolved, clear the alert. Clearing the alert removes the alert
from the alert list in the Alert tab.

1.

Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

In the Networks section of the Network Diagnostics ribbon, select the network to clear
the alerts in.

Select the device to clear alerts and click the Alerts tab at the bottom of the main window to
view the list of alerts for the device.

Click Clear Alerts.

The alert indicator for the device in the Path View is removed and all the alerts are cleared
from the Alerts list
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7.4.4. Create Alert Reports

« Generate a report by date range of devices in a network that are in alert state.

« Using areport lists the devices by serial number and provides a way to print, save as a PDF
file, or to view the devices with alerts in Microsoft Excel.

« Reports can be helpful if troubleshooting multiple devices or comparing a troubled device
with others that are not in an alert state.

Procedure
1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to create
an alertreportin.

3. Inthe Options drop-down menu in the Network Title ribbon, select Alerts > View
Report.

4. Inthe Alert Reporting window, enter the date range to include alarm data in the report.

Example: To see alarm data for the last month, enter the first and last days of that month in
the corresponding fields.

5. Inthe Alert Level drop-down list, select from one of these options:
« All-Includes all alerts that occurred for the device in the date range you specify.
« Alarms - Includes only alarms that occurred for the device in the date range you
specify.
« Warnings - Includes only warnings that occurred for the device in the date range you
specify.
6. Click Report to generate the report.
The Report opens in a separate window and is sorted by serial number. Figure 41

Alerts Report o B R
g | 1 of 1 | ) # | SFE A - | oo

Alerts Report

Netwaork
FreeWave FGR Fint Radio Type Network

Network version Type

026-4318 2.66 FGR 900 MHz Slave
Series

Type Field Abave Below  “alue  First Alert Last Alert  Ack

Warning WSWR 30.00 69.00 12j2z[/2009 12j2zf2009 True
10:11:30 AM 1001322 aM

Figure 41: Example: Alerts Report
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7.4.5. Polling Devices With Alerts

Use this procedure to poll only the devices in the network that currently have alarms or warnings.

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to poll
devices with alerts.

3. Inthe Polling drop-down menu in the Network Title ribbon, select one of these options:
» Poll Radios With Alerts - Polls only the devices with an alarm or warning condition.
» Poll Radios With Warnings - Polls only devices with a warning condition.
« Poll radios With Alarms - Polls only devices with an alarm condition.

7.4.6. Setting Alert Definitions
Alerts are categorized as either warnings or alarms.

« The set of diagnostic parameters that are set as warnings or alarms is the same.

o Where the alert is activated determines whether Tool Suite shows the condition as a
warning or an alarm in the Network Diagnostics application.

[ Note: The network must be stopped before the alert definitions can be changed. ]

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to define
alert definitions.

3. If necessary, click Stop to stop polling the network.

4. Inthe Options drop-down menu in the Network Title ribbon, select Alert > Modify Alert
Definitions.
The Alert Definitions dialog box opens. Figure 42

5. Click either the:
« Alarms tab to define parameters that flag a device with an Alarm e

« Warnings tab to define parameters that flag a device with a Warning

6. Select the check box in the Active column for the diagnostic to activate an alarm or warning
for a device condition.

7. Inthe Warn Below and Warn Above fields for the activated diagnostics, set the range to
when something is considered in fault.
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Example: Alarm:

If the Warn Below field for the In Margin diagnostic parameter is set to 20.00 dB in the
Alarms tab, if the device's margin falls below 20.00 dB, the system flags the device with an

Alarm in the Network Diagnostics application and changes the device icon to e inthe

Path View

Example: Warning:

If the Warn Below field for the In Margin diagnostic is set to 20.00 in the Warnings tab, if
the device's margin falls below 20.00 dB, the system flags the device with a Warning in the

Network Diagnostics application and changes the device icon to

in the Path View.

Alert Definitions

| Alarms

3 In Signal
In Moise
Out Signal
Out Maise
In Margin
Out Margin
Valtage
Temperature
Missed Palls
VSWER
Receive %o

Diag Poll/ Transmit %2

Field

Warn Below

20,00
20,00

§0.00

Warn Above Active

OO

L0.00
30,00

OFEREOOREOO

Figure 42: Alert Definitions dialog box - Warning tab
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7.4.7. Showing Only Devices With Alerts

Use the filtering option to view only devices in the Path View that are in an alert status.

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to view
devices with alerts.

3. Inthe Filter drop-down menu in the Network Title ribbon, select one of these options:
« Show Alerts - Shows all devices with an alarm or warning in the Path View.
« Show Warnings - Shows only devices with a warning condition in the Path View.
« Show Alarms - Shows only devices with an alarm condition in the Path View.

4. Optional: In the Filter drop-down menu, select Show All to return to an unfiltered view.
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7.5. Run and View Network Diagnostics

Important!: Review the Network Diagnostics Best Practices (on page 69) before running the
Network Diagnostics application.

After a network is defined, select the network from the Networks section of the Network
Diagnostics ribbon and click Start to begin gathering diagnostic data.

As Tool Suite receives information from the devices in the network, it populates the Path
View and the graph for the selected device begins to show information about how the
device is functioning.

Tool Suite offers multiple ways to review network diagnostic data.

Note: If running diagnostics on an Ethernet network, broadcasts may be blocked through
certain brands of routers. If data is not appearing in Tool Suite and other factors have been
ruled out, try connecting the Ethernet cable directly to the computer's Ethernet port.

Poll Devices for Diagnostics (on page 81)

Graph View (on page 83)

« Shows all the current data in a chart.

History View (on page 86)

« Shows at-a-glance history of the parameters polled in past network diagnostic runs.
« Thisview is only available in serial and TCP networks.

Summary View (on page 87)

« Shows the most recent diagnostics in summary table format.

Trend Analysis View (on page 88)

« Shows atrend analysis of the parameters polled in past network diagnostic runs.
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The Poller Status, located at the very bottom of the window, indicates if the poller is connected or
disconnected. Figure 43

Note: If the poller is connected, but no radios are added to the Path View, double check that the
diagnostic cable is connected to the Master radio.

€9 NetworkDiagnosticsEthernetTest - Plus Ethernet
Path WView | Summary View

&) Noradios have been defined

Radio Count: 0 Poller Statust Lonnesciing -

Figure 43: Poll Status

7.5.1. Poll Devices for Diagnostics

If devices are not automatically discovered, or the settings have not populated in the Network
Diagnostics application, they can manually be polled.

Note: While polling an active Ethernet network, you can poll a range of IP addresses the network
spans to discover devices.

» Topolladevice, Tool Suite must be actively polling the network.
« The polling indicator light appears as a:
« Solid Green = lightwhen Tool Suite is polling a network
« Solid Red (Bright) = light if the network is disconnected.
See:
« Poll Ethernet Devices for Diagnostics (on page 82)
« Poll Serial Devices for Diagnostics (on page 82)
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7.5.2. Poll Ethernet Devices for Diagnostics

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to poll
devices.

3. Inthe Options drop-down menu in the Network Title ribbon, select Poll Radio.

4. Inthe Start Address and End Addresstext boxes, enter the first and last IP addresses in
a range of addresses to poll devices.

5. Click Poll to poll the range of addresses.

7.5.3. Poll Serial Devices for Diagnostics

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network to poll
devices.

3. Inthe Options drop-down menu in the Network Title ribbon, select Poll Radio.

&

In the Serial Numbertext box, enter the serial number of the device to poll.
5. Click Poll to poll the device.
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7.6. Graph View

The data from a network diagnostic can be viewed in graph form. Tool Suite charts all the current
data for the device on a single graph. Zoom in and out on different parts of the graph for greater
magnification.
The graph contains this data across the top of the graph: Figure 44
« Last Response - Displays the date and time for the last time the device responded to a
poll.

« Missed Polls - Tracks the number of times Tool Suite polled the device without a
response.

« After there is a successful poll, the Missed Polls number resets to zero.

» Data Sent - Only available for Ethernet networks, Data Sent tracks the increasing number
of polls a device has sent out.

« When running diagnostics for serial devices, the Data Sent number remains at zero.

Path View | Summary View
2440099
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L N ight click for additional options
0412 24 GHz Series Last Response: 5/18/2010 1:55:21 PM Missed Polls: 0 Diata Sent: 0
o 244-0107
M4 12 24 GHzeries 100
s 244-0089
4ih 12 24 GHz Series 80
60
40
- T T —
20 [ —
0 T T T T T T
1:58:00 PM 1:58:20PM  1:58:40PM  1:59:00 PM  1:59:20 PM  1:59:40 PM
e | Margin === Out Margin == Receive % == [iag Poll % Lwg VSWR |
Qutbound Inbound Receive Diag Poll Average
Signal  Moise  Margin Signal  Moise  Margin VSWR
0 130 0 130 = 100 = 100 = 150
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w00
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@m dBm 4B @m dEm 9B * *
Diagnostics | Settings | Alerts | History
Radio Count: 4 Poller Status: Connected Last Rx: 244-0089 <1> 4 View History
J

Figure 44: Example: Graph View

See:
« Show the Graph View (on page 84)
« Change the Data Shown in the Graph (on page 84)
o Zoom In and Out in the Graph (on page 85)
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7.6.1.
1.

Show the Graph View

Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

In the Networks section of the Network Diagnostics ribbon that contains the device to
view.

In the Radio tree view, select the device to review.
Click the Diagnostic tab at the bottom of the Network Diagnostics window.

Change the Data Shown in the Graph

. Click Network Diagnostics in the Applications pane to view the Network Diagnostics

application.

In the Networks section of the Network Diagnostics ribbon that contains the device to
view.

In the Radio tree view, select the device to review.

Right-click anywhere in the graph and select or deselect the parameters to view or not.
Figure 45
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Figure 45: Select Parameters Right-click menu

5. Optional: Select Chart Span and the time period to view to change the time period shown
in the graph.
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7.6.3. Zoom In and Out in the Graph

1. Inthe visible graph, hold down the left button on the mouse at the uppermost or lowest point
of the area on the graph to zoom.

2. Drag the mouse across the entire area to zoom.

3. Tozoom out, click the O in the top upper left corner (controls zooming out at the Y-axis)
and/or the lower left corner (controls zooming out at the X-axis) of the graph. Figure 46

Right click for a

........

-36 <

Figure 46: Example: Zoom Out

Note: The number of times the graph is magnified equals the number of times needed to click
either one of the reset points to return the graph to the normal view.
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7.7. History View
The History view displays a log of Slaves/Endpoints that recently transmitted data.

« This view is most useful if the network contains a chatty Slave.
« Use this view to review a pattern of repeated data transmissions.

Important!: This feature is only available in serial and TCP/IP networks.

The last received radio is shown next to the View History button.

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon that contains the device to
view.

3. inthe Radio tree view, select the device to review.
4. Click View History at the bottom of the Network Diagnostics window. Figure 47
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Figure 47: Example: View History

5. Inthe Results Displayed field, select how many results to show in the list (10 to 100).
6. Optional: Click Refresh to manually refresh the history list.

Note: If the Auto Refresh check box is selected, the list automatically updates.
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7.8. Summary View

The Summary view shows the most recent polls and provides an overview of all the diagnostics
on a single page.

Nt
Use the Summary view to copy and paste data into a Microsoft Excel spreadsheet.

Serial and TCP/IP Summary View

(‘? FreeWave FGR Network - COM4 5 Polling S71
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0264318 Sve | 12/23200020339PM 0 10 3 u 8.4 0 0 .1 183 419100 FGR 900 MHz Series 266 a5s705 L
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. . . .
Figure 48: Serial and TCP/IP Summary View
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Figure 49: Plus Ethernet Summary View

7.8.1. Show the Summary View

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon that contains the device to
view.

3. Inthe Radio tree, select the device to review and click the Summary tab.

7.8.2. Copy Data to a Microsoft® Excel Spreadsheet

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon that contains the device to
view.

3. Inthe Radio tree, right-click the device and select Select All.
4. Copy and paste the information into an Microsoft® Excel spreadsheet.
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7.9. Trend Analysis View

The Trend Analysis view shows an analysis of time-specified reported data.

9124898
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Right click for additional options.
100 —
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60 1
404
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D T T T T T T T T T T T T
1:15:00 PM 1:25:00 PM 1:35:00 PM 1:45:00 PM 1:55:00 PM 2:05:00 PM
1:20:00 PM 1:30:00 PM 1:40:00 PM 1:50:00 PM 2:00:00 PM 2:10:00 PM
=== |0 Margin == Qut Margin = Receive % = Diag Poll % HLorg VEWR
Diagnostics | Settings | Alerts | History
7.9.1. Show the Trend Analysis View

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics

application.

2. Inthe Networks section of the Network Diagnostics ribbon that contains the device to

view.

3. Inthe Radio tree view, select the device to review.

4. Click the History tab at the bottom of the Network Diagnostics window.

5. Inthe Time Span field, select the time period for to show data.
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7.9.2. Zoom In and Out in the Trend Analysis

1. Inthe visible graph, hold down the left button on the mouse at the uppermost or lowest point
of the area on the graph to zoom.

2. Drag the mouse across the entire area to zoom. Figure 50
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Figure 50: Trend Analysis dialog box

3. Tozoom out, click the O in the top upper left corner (controls zooming out at the Y-axis)
and/or the lower left corner (controls zooming out at the X-axis) of the graph. Figure 51

Right click for =

Last Response: 522/2008 11:42:42 AM

-36

Figure 51: Example: Zoom Out

Note: The number of times the graph is magnified equals the number of times needed to click
either one of the reset points to return the graph to the normal view.
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7.10. Parameter Definitions and Recommended Values
When using the Network Diagnostics application, these parameters are available in each of the

views.

« Refer to the parameter definitions and the recommended values for each.

« For more information about each of these parameters in a particular device, see that
device's user manual or addendum.

Parameter Description
The percentage of the time that the radio reported back diagnostics data
when polled.
Diag Poll % « If the device transmits a lot of data as part of its normal operation, it
. has less time to respond to the Master polling it for diagnostics data;
(serial only)

In/Out Margin

Inbound Noise
Inbound Signal

Outbound Noise
Outbound Signal

in that case, the diagnostics response rate decreases.
« Ifthis valueis 0, it may be because this device is disconnected from
the network.
The difference between the signal and noise.

« In Margin is the spread of points between the Inbound Noise and
Inbound Signal.

« Out Margin is the spread of points between the Outbound Noise
and Outbound Signal.

o A spread of 20 dB or greater is considered ideal.

FREEWAVE Recommends: A minimum of 20 dB. This
recommendation means the signal needs to be 20 dB higher than
the noise level.

The noise at the selected Slave or Repeater.

The signal the Slave or Repeater receives from the Master or Repeater to
which that device is linked.

The noise in the outbound transmission at the Master or Repeater

The signal the Master or Repeater receives from the Slave.
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Parameter Description

The percentage of data packets that were successfully transmitted from
the Master to the Slave on the first attempt.

« A number of 75 or higher indicates a robust link that provides very
good performance even at high data transmission rates.

« A number of 15 or lower indicates a weak or marginal link that
Receive % provides lower data throughput.

« An Overall Receive Rate of 100% provides approximately 100
KBaud of bandwidth with an RF Data Rate setting of 3 and
approximately 150 KBaud of bandwidth with an RF Data Rate of 2.

« These numbers are reduced approximately 50% if one or more
Repeaters are in the network.

Temperature The physical temperature of the device.

The percentage of packets the device sends sent that successfully reach
the upstream device (Gateway or a Repeater).

« This statistic shows 0.00% on a Multipoint Gateway or Multipoint

Transmit % (Ethernet Repeater.
only) « This statistic is only valid on Multipoint Endpoint devices.

FREEWAVE Recommends: A minimum of 75% for proper
device operation.

The input voltage the device receives.

This value should be within the specified range of the device that is being

read.
Voltage

Example: The FGR series radios should be between the 6 and 30
Volts DC.

The amount of signal being reflected back into the device.

« Areading between 0 and 5 is considered good;
» between 6 and 25is Fair;

VSWR

« between 26 and 30 or higher is considered Poor and needs attention.
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7.11. Change Settings Over the Air

In the Network Diagnostics application, view a device's current configuration and change these
settings over the air:

o Operation Mode

« BaudRate

« Transmission Characteristics
« Multipoint Parameters

FREEWAVE Recommends: When making changes, always start at the farthest site in the line
(e.g., the Slave farthest from the Master).

1. Click Network Diagnostics in the Applications pane to view the Network Diagnostics
application.

2. Inthe Networks section of the Network Diagnostics ribbon, select the network that
contains the device to change.

3. Inthe Radio tree view, select the device to change.

4. Click the Settings tab at the bottom of the Network Diagnostics window to view the
device's current settings.

5. Inthe parameter field to change, make the necessary changes.
6. Right-click in the field to change and select Change.
7. Answer Yes at the prompt to continue.

Note: While the change is being sent to the device, a warning icon appears next to the field
that is changing. Figure 52

Setup Port Both
Turn On Delay A0
Turn Off Delay 1]
Flow Control MNane
Use Break to Access Setup Off

Figure 52: Example: Changing Field

The new value appears in the field and the warning icon is no longer visible when the
settings changed.

VLI
"“' If the value does not show right away, try polling the device to verify the setting was
changed.
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8. Setup Terminal Application

Use the Setup Terminal application to configure a device using a terminal window that mirrors
the menu structure when connected to the device using a terminal emulator.

\LE)
=" Use the Setup Terminal instead of the Configuration application or an external terminal

@ emulator to program devices in the network.

Important!: I/O Expansion Serial Base and Expansion modules are NOT compatible with either
terminal emulators or the Tool Suite Setup Terminal application.

Configure these devices using the parameters in the Configuration application.

For more information, see 1/0O Serial Base and I/O Expansion Device Parameter Tabs (on page 49).
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Click Setup Terminal in the Applications pane. Figure 53
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Figure 53: Applications > Setup Terminal
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8.1. Configuring Devices Using Setup Terminal

Use the Setup Terminal application to configure a device using a terminal window that mirrors
the menu structure available in an external terminal emulator.

Important!: All changes made through Setup Terminal are sent to the device immediately.

Be sure to disconnect the device after making any changes before running diagnostics for the
device.

1. Click Setup Terminal in the Applications pane to display the Setup Terminal
application.

2. Verify the device to configure is connected to the computer and that all diagnostics are
stopped.

3. Selectthe COM Port the device is connected to from the drop-down list in the Setup
Terminal ribbon and click Connect.
The setup menu for the device appears in the Setup Terminal window. Figure 54

MATH MELNU
I2I0 20 - 2400MHz Versien 9,70k
Takle 0, 2400 To 2483 MHz=
Modem Serial Number 244-0086
Model Cods IZ2IOC

(0 Set Cperation Mode

(1) Set Baud Rate

(23 Edit Call Book

(3} Edit Radio Transmission Characteristics
[4) Show Radio Statistics

(5 Edit MultiPoint Parameters

(83 Chg Password

{99 FGRIO Setup

(Esc) Exit Setup

Enter Choice |

Figure 54: Setup Menu

4. Type the number of the menu to expand and make updates as necessary.

5. Press Esc to exit the menu or click Disconnect in the Setup Terminal ribbon to
disconnect the device.
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9. Spectrum Tool Application

The Spectrum Tool application puts a supported serial device into a listening mode that monitors
the ambient noise at various spectrum points as the radio hops through them.

Important!: The Spectrum Tool application is only available for 900 MHz, 2.4 GHz, and 1.3 GHz
serial devices.

Click Spectrum Tool in the Applications pane. Figure 55

N/A - 1
| 6 =1 *e80
FREEWAVE
Connection
Applications
E
Configuration
Metwork Diagnostics
(/f \)}.
‘P
Local Diagnostics
nectum Taal ‘

\._/H

Spectrum Tool

‘ — Noise == Average —— Peak |

Available applications

Figure 55: Applications > Spectrum Tool
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9.1. Run a Spectrum Analysis

Use the Spectrum Tool to monitor the ambient noise at various spectrum points as the radio
hops through them.

Note: To run an analysis for a device, the device must be taken offline.

Procedure
1. Click Spectrum Tool in the Applications pane to show the Spectrum Tool application.
2. Connect the device and click Start in the Spectrum Tool ribbon.
3. Click Yes at the prompt to place the device offline and run the analysis. Figure 56

FreeWave Tool Suite

T'f Putting the radio in spectrum mode will cause it to go offline,

Are wou sure wou wish to continue

Figure 56: Confirm Offline Mode message

Tool Suite runs the analysis and updates the graph as it receives data from the device.

Figure 57
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B .Stnu RDE::; Print FREEWAVE

Applications
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CPData Logger 97 6

T T T T
2400 24166 24332 24498 2466.4 2483

Frequency (MHz)

Available applications

Figure 57: Spectrum Analysis Graph

4. Optional: Click Reset Data in the Spectrum Tool ribbon to reset the peak and average
trend lines in the graph.
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9.2. Stop a Spectrum Analysis
1. Click Spectrum Tool in the Applications pane to show the Spectrum Tool application.
2. Click Stop in the Spectrum Tool ribbon.

9.3. Print a Spectrum Analysis Graph
1. Click Spectrum Tool in the Applications pane to show the Spectrum Tool application.
2. Click Print in the ribbon to open a print preview of the graph.

3. Click the Printer icon in the upper left corner of the print preview window.
The document is sent to the default printer designated on the computer.
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10. Updates Application

Use the Update application to review the most recent Tool Suite updates available and to update
the version of the Tool Suite software.

Use the Updates application to:
» Review the release notes for each upgrade version of the Tool Suite software.

« The Release Notes include all the information about additions and changes in each
release of the Tool Suite application.

« Verify the latest version of Tool Suite is running.
« Update to the most recent Tool Suite version.

Click Updates in the Applications pane. Figure 58

Note: After upgrading to Tool Suite v2.8.5, any future upgrades make an automatic backup copy of
(all Configuration application data) files in the C:\Program Files\FreeWave
Technologies\Freewave Suite\backups directory.
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Applications Click the Check Updates button to check for new updates.

A\ Release Notes
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MNetwork Diagnostics
p

Local Diagnostics

Version 2.11.2 - 10/8/2019:

« General: Updated logo.

o Firmware: Added FGR3 v11.00.11 firmware image.

Version 2.11.1 - 9/12/2019:

@ « Configuration: Resolved issue with reading IOE/IOEX modules.
Spectrum Tool
- Version 2.11.0 - 3/14/2019:
Setup Terminal
ﬂ s General: Added FGR3 radio support.
= e General correctly identifies MM2-2X5W and MM2-9X5W-CC radios.
Lingdates
—] port autodetection (no longer need to restart to detect new COM ports).
ﬁ edback if COM port is in use by anather component or application.
= ssue with Operation Mode tab not displaying on TDMA-enabled radios.
< ue with closing Plus Ethernet discovery when no discovery sessions were started.
paates
ue with Plus Ethernet discovery object reference error that occured under some Ethernet interface
configurations.
Available applications v

Figure 58: Applications > Updates

10.1. Back Up Tool Suite Data

In Tool Suite, the items created (e.g.,networks and templates), are saved in the
file.

« InTool Suite v2.8.5 and later, a backup copy of this file can be created and saved to any
location on the computer or network.

« Back up data ensures there is always a copy of the network and device settings in the event
of a computer malfunction.

Note: Tool Suite issues a prompt to create a data backup seven days after the last backup was
completed.

After upgrading to Tool Suite v2.8.5, any future upgrades make an automatic backup copy of
(all Configuration application data) files in the C:\Program Files\FreeWave
Technologies\Freewave Suite\backups directory.

« Manually Backup Tool Suite (on page 101)
« Restore Tool Suite Data from a Backup (on page 101)
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10.2. Manually Backup Tool Suite
1. Fromthe File menu, select Back Up Data to display the Select Backup File dialog box.
2. Navigate to the directory where you want to save the backup file.

By default, the system displays the C:\Program Files\FreeWave
Technologies\Freewave Suite\backups directory and the file name is

FREEWAVE Recommends: Accept the default file name.

3. Click Save to save the file.

10.3. Restore Tool Suite Data from a Backup

Caution: Restoring data from a backup copy completely replaces the current Tool Suite data
. !. with the data in the backup file.

[ Important!: Save a backup copy of the current Tool Suite data prior to restoring from a backup. ]

1. InWindows® File Explorer, go to C:\Program Files\FreeWave
Technologies\Freewave Suite\backups and locate the
file with the date and time stamp to restore data.

[ Important!: This may not be the file with the latest date and time stamp.

Note: If the Tool Suite data was backed up manually to another location, go to that location
to locate the file.

2. Rename thefile to .
3. Copy the renamed file to the C:\Program Files\FreeWave Technologies\Freewave
Suite\data directory.

4. Open Tool Suite.
The data from the copied file is read into Tool Suite.
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10.4. Update Tool Suite at Program Startup

Using an active Internet connection, Tool Suite automatically connects to the FreeWave network
to determine if the latest version of Tool Suite is running.

1. Ifanew update is available, a prompt appears that new updates are available.

2. Click Yes to download the update.
The Updates application opens.
The update downloads and Tool Suite prompts to install the update.

3. Click Apply Updates in the Updates Application ribbon to install the updates.
Tool Suite installs the updates, and re-launches after the install is complete.

10.5. Update Tool Suite From an Open Session

If currently running Tool Suite and to install updates, review the release notes for the updates
listed in the Update application and follow the steps below.
1. Click Updates in the Applications pane to open the Updates application.

2. Click Check Updates in the Updates ribbon.
A prompt appears indicating whether there are updates available to install.

3. Ifthere are updates, click Yes to download the updates.
When the download process is complete a message appears prompting installation of the
updates.

4. Click OK to close the prompt.
5. Click Apply Updates in the Updates ribbon.
Tool Suite applies the updates and re-launches after the install is complete.

LUMOO30AB Rev Oct-2019 Page 102 of 114 Copyright© 2019 FreeWave

This document is subject to change without notice. This document is the property of FreeWave Technologies, Inc.
and contains proprietary information owned by FreeWave. This document cannot be reproduced in whole orin
part by any means without written permission from FreeWave Technologies, Inc.



Tool Suite

10. Updates Application User-Reference Manual

10.6. Update Tool Suite Locally

To update Tool Suite on computers that do not have an active Internet connection, download the
latest updates to a computer that has a network connection, and distribute the installation file on a
network drive or a drive to take into the field or carry throughout the office.
1. From a computer with an Internet connection, download the latest Tool Suite update from
support.freewave.com.

2. Save the update file to a folder on a local or network drive or portable drive.

3. After the update file has been saved (if the package has been saved to a jump drive or CD,
make sure the hardware is plugged into the computer or the CD with the update package is
in the computer’'s CD-ROM), click Updates in the Application pane.

4. Click Local Update in the Updates ribbon.
Tool Suite opens the last folder that was accessed through the software.

Note: If the update file was saved in a different location, navigate to the correct directory,
select the update file, and click Open.

Tool Suite installs the updates and re-launches after the install is complete.
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10.7. Update Tool Suite from Versions 2.0.1.2 and Earlier

Due to database changes, if upgrading from Tool Suite version 2.0.1.2 or earlier, the old
database must be merged with the new database format.

Important!: Tool Suite databases from versions 2.0.1.2 and earlier are not compatible with Tool
Suite version 2.2 and above databases.

Tool Suite versions 1.4.1 and below cannot upgrade to version 2.6 or above from the Updates
application.

To upgrade to the latest version, first un-install Tool Suite, then download the latest installer from
support.freewave.com.

1. Click Updates in the Applications pane to open the Updates application.
If the system requires updates, a New updates are now available, would you like to
download? message appears.

2. Click Yes to continue the update process.

3. Click OK at the prompt that opens after the updates download.
A Confirmation of Database Upgrade message appears asking to merge databases.
Figure 59

Database Upgrade Required gl

- It appears you have an outdated database schema.
y wWauld wou like to upgrade wour database?

MCTE: if wou would like to use data created in previous versions of Tool Suite, a database upgrade is required,

Please read the Following options carefully before proceeding:

YES - Will continue on and merge the databases. This may take several minutes depending on the amount of data wou have stored.
MG - Selecting this option will not import any previoushy saved data into the new format and all data will be lost,

CANCEL - Cancels this operation, the application will exit,

| ¥es |[ Ko ][ Cancel ]

Figure 59: Confirmation of Database Upgrade message

4. Select one of these options in the merge databases prompt:
« Click Yes to merge databases.
o Click No to update Tool Suite without merging databases.

Caution: If No is selected and the update is continued in Tool Suite, all previously
! » saved data is deleted after the update.

[ Note: If No is selected, Tool Suite restarts automatically. ]

« Click Cancel to exit without completing the upgrade.
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Note: If Yes is selected, a progress bar opens while the databases are merging. Figure 60
The merge can take several minutes.

Merging Database

Processing.. (This may take several minutes to complete)

Figure 60: Merging Database Progress bar

After the merge is complete, Tool Suite restarts and then reloads automatically.
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11. Release Notes

These sections describe the additions, changes, and known limitations in each software version
for the Free\Wave Tool Suite. The most recent version is listed first.

\1LY;
M=~ The latest firmware and software versions and the most recent list of known limitations and
@ workarounds are available on support.freewave.com.

« Version 2.11.2 (on page 107
! Pag ) « Version 2.8.7.5 (on page 110)

« Version 2.8.7.3 (on page 110)
« Version 2.8.7.2 (on page 110)
« Version2.8.7.1 (on page 111)
o Version2.8.7.0 (on page 111)
» Version 2.8.6.0 (on page 111)

(
« Version2.11.1 (on page 107)
» Version 2.11.0 (on page 107)
« Version 2.10.0 (on page 108)
« Version 2.9.2 (on page 108)
« Version 2.9.1 (on page 109)
» Version 2.9.0 (on page 109)
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11.1. Version 2.11.2
Release Date: 10/8/2019

Version 2.11.2

Update Type Description

Firmware Added FGR3 v11.00.11 firmware image.
General Updated logo.

11.2. Version 2.11.1
Release Date: 9/12/2019

Version 2.11.1
Update Type Description

Configuration Resolved issue with reading IOE/IOEX modules.

11.3. Version 2.11.0
Release Date: 3/14/2019

Version 2.11.0
Update Type Description

Configuration Fixed issue with Operation Mode tab not displaying on TDMA-enabled radios.

Fixed issue with closing Plus Ethernet discovery when no discovery sessions were

Diagnostics started.

Diagnostics Fixed issue with Plus Etherngt disc.:overy object reference error that occurred under
some Ethernet interface configurations.

Diagnostics Fixed issue with GX/GXM radios with v9.8.3 firmware being misidentfied.

Firmware Added FGR3 v11.0.08 firmware image.

Firmware Added FGR2/ MM2 v1.7.04 firmware image.

Firmware Added GX/ GXM v9.8.3 firmware image.

Firmware Added [2-I0S 9.81 firmware image.

Firmware Added LRS-455 1.79 firmware image.

Firmware Fixed LRS-455-EU 1.73 firmware image.

General Added FGR3 radio support.

General Now correctly identifies MM2-9X5W and MM2-9X5W-CC radios.

General Added COM port autodetection (no longer need to restart to detect new COM
ports).

General Improved feedback if COM port is in use by another component or application.
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11.4. Version 2.10.0
Release Date: 05/04/2015

Version 2.10.0
Update Type

Description

Configuration Removed the (missing or bad snippet) on Plus Ethernet radio discovery form.

Fixed false firmware update notification when a radio has newer firmware than is

Configuration currently available in (missing or bad snippet).

Remote LED setting now defaults to (1) Remote and Local on all radio templates

Configuration that contain it.

Configuration

Configuration

Configuration

Local Plus Ethernet radio discovery now uses all network interfaces and supports
firmware v3.01 and higher.

Removed HT2+ radio support.
Added Plus Ethemnet firmware v2.34 and v3.01 parameter support.

Firmware Added LRS-455 v1.77 firmware.
Firmware Added FGR2/ MM2 v10.6.8 firmware.
Fixed startup error due to configuration file corruption. Tool Suite will now reset the
General ) C . : ) o : .
configuration file automatically, and will prompt if an application restart is required.
General Removed CP Data Logger and Modbus Interface tools.
Fixed CSV export error that occurred when a discovered radio had not been fully
General . e . . .
identified using Network Diagnostics.
General Fixed error recognizing recent FGR2-10S radios.
Installation Removed requirement for separate Microsoft Report Viewer installation.
Network Fixed issue with setting Terminal Server TCP port above 32767 in network
Diagnostics settings dialog.
Nfatwork . Fixed issue with FGR2/MM2 radios reporting incorrect firmware version number.
Diagnostics

11.5. Version 2.9.2
Release Date: 11/13/2013

Version 2.9.2
Update Type

Description

Configuration Added Clear Counter on Read setting for I/O Expansion modules

Configuration Added ability to create a template from an existing radio or radio template.

Firmware Added v2.2.2 firmware for |/O Expansion modules.

Resolved occasional BackgroundWorker error when selecting an application mode

General from the Applications list.
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11.6. Version 2.9.1
Release Date: 7/15/2013

Version 2.9.1
Update Type

Description
Changed Rectifier Voltage to use VDC instead of mVDC.
Added 9.77 firmware for FGR2 900 MHz 10 Slave and FGR2 900 MHz 10

CP Data Logger

Firmware Slave (Enclosed) radios.
. Added v10.6.7 firmware for FGR2 900 MHz Series and MM2 900 MHz Series

Firmware .
radios.

General Added support for additional MM2 radios.

Installer Fixed prerequisite installation issue that caused missing SQL Server Compact
error on some systems.

Ngtwork . Fixed firmware version identification for Serial radios.

Diagnostics

Ngtwork . Fixed discovery of Plus Ethernet radios running older firmware.

Diagnostics

Updater Fixed issue that prevented log file from being written after updating to 2.9.0.

11.7. Version 2.9.0
Release Date: 5/1/2013

Note: When polling serial radios using the Network Diagnostics tool, Tool Suite may misinterpret
the firmware version number of older firmware releases.

Tool Suite always returns the correct firmware version when reading the radio directly using the
Configuration tool.

Version 2.9.0
Update Type

Description

Configuration
Configuration
Configuration
Firmware
Firmware
General
General
General

General

Fixed miscellaneous typographical and validation issues.

Resolved issue with copying radio settings from IM template to 12 radio.
Now permits multiple repeaters in Plus network design.

Added v10.6.6 for FGR2 and MM2 900 MHz series (AES settings excluded).
Added v9.7.9for 12 and GX 2.4 GHz series (AES settings excluded).
Resolved form and control scaling issues on Windows 7.

Fixed issue that caused network names to be truncated in network selector.
Resolved issues with misidentifying radio models.

Added support for additional HT 900 MHz series radios.
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Version 2.9.0
Update Type Description
General Added log file to capture key application events and errors.
General Added support for LRS 415 MHz series radios
Ngtwork . Polling interval value now displays automatic interval when Auto is selected.
Diagnostics
Network Polling engine now automatically reconnects if terminal server connection
Diagnostics becomes temporarily unavailable.
Ngtwork , Improved overall performance and stability.
Diagnostics
Ngtwork . Resolved some issues that could lead to duplicate radios being discovered.
Diagnostics
Network o . L

) . Improved overall reliability of serial radio discovery.
Diagnostics
Ngtwork , Resolved issue that prevented radios from appearing in the Radio Data History.
Diagnostics
Network Can now sort by name and serial number independently on Summary View and
Diagnostics Radio Data history views.
Network . . . . .
Diagnostics Resolved issue with COM ports locking up when stopping network polling.
Updates Resolved issue that prevented non-US users from updating Tool Suite.

11.8. Version 2.8.7.5
Release Date: 10/5/2012

Version 2.8.7.5
Update Type Description
General Added support for additional FGR 900 MHz Series radios.

11.9. Version 2.8.7.3
Release Date: 8/2/2012

Version 2.8.7.3
Update Type Description
General Added support for additional FGR2 900 MHz Series radios.

11.10. Version 2.8.7.2
Release Date: 6/25/2012
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Version 2.8.7.2
Update Type Description
General Added support for additional FGR2 900 MHz Series radios.

11.11. Version 2.8.7.1
Release Date: 6/5/2012

Version 2.8.7.1
Update Type Description

Updates Fixed issue with downloading updates.

11.12. Version 2.8.7.0
Release Date: 5/29/2012

Version 2.8.7.0
Update Type Description

Configuration Fixed issue with layout of Ethernet radio templates in Network Design.

Fixed issue with Long Distance Enabled setting for HTPlus radios not being

Configuration honored.

Fixed issue with Frequency Zones button being enabled for invalid Modem Mode
and Network Type combinations.

Added support for v2.26 firmware for GX-PE, FGR2-PE, FGRPIus, and HTPIus
Ethernet radios.

Configuration

Configuration

Pre- and Post-Packet Timeout values are now automatically set to appropriate
Configuration default values when Serial Modbus RTU and Serial Baud Rate settings are
changed on Ethernet radios.

Firmware Fixed issue with IM 2.4 GHz v3.66 firmware image.
Local ) .
! , Added support for v2.26 firmware on Ethernet radios.
Diagnostics
Network Fixed issue with automatic and manual polling interval selections not being
Diagnostics honored.

11.13. Version 2.8.6.0
Release Date: 3/26/2012

[ Note: Version 2.8.6.0 was a limited release. ]
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Version 2.8.6.0

Update Type

Description

Configuration

Configuration
Configuration

Configuration
Configuration

Configuration

Voltage or Current value is automatically set to Current whenever I/O Mode is set
to Analog Output for IOE modules.

Added detection of invalid characters in Ethernet radio settings.
Added support for 2.23 firmware for FGR2-PE radios.
Fixed issue with saving Current Span (uA) register value for IOE modules.

Added support for upgrading a stack of IOE-X-4422PC / IOE-X-4422P modules to
a stack of IOE-4422 / |IOEX-4422 modules.

Added Counter Debounce setting and renamed other IOE settings for clarity.

Firmware Added v2.2.0 firmware for IOE modules.
General Updated user manual.
Network Fixed issue with polling 12 radios.
Diagnostics
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Appendix 12: Legal Notices

Any product names mentioned in this manual may be trademarks or registered trademarks of their respective
companies and are hereby acknowledged.

This manual is for use by purchasers and other authorized users of FreeWave products.

No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical,
or for any purpose without the express written permission of FreeWave Technologies, Inc. FreeWave reserves
the right to make changes to this manual without notice. FreeWave assumes no responsibility or liability for the
use of this manual or the infringement of any copyright or other proprietary right.

FreeWave products are designed and manufactured in the United States of America.
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